
 

 

1 

 

 

   

 

 

V.1.3  

 

 

 

PAYMATE SOFTWARE CORPORATION 

Last Updated: March 2024 

 

HARMONY 
HUMAN RESOURCES 

USER MANUAL 



 

 

2 

 

Table of Contents 
Common Icons and Symbols ................................................................................................................................... 7 

Welcome to Harmony ............................................................................................................................................. 8 

About Harmony Human Resources ......................................................................................................................... 8 

About This User Manual .......................................................................................................................................... 8 

Software Version ..................................................................................................................................................... 8 

1.0     Logging In ....................................................................................................................................................... 9 

2.0     Selecting a Module ...................................................................................................................................... 10 

3.0 Upgrading Your Database ........................................................................................................................ 10 

4.0     Navigating Through Harmony ...................................................................................................................... 11 

5.0     Basic Company Configuration ...................................................................................................................... 12 

5.1     Setup ........................................................................................................................................................ 12 

5.2     Company Information .............................................................................................................................. 13 

5.3     Preferences .............................................................................................................................................. 14 

5.4     Departments ............................................................................................................................................ 16 

5.4.1     Creating a Department ..................................................................................................................... 16 

5.4.2     Editing a Department ....................................................................................................................... 17 

5.4.3     Deleting a Department ..................................................................................................................... 17 

5.5     Holiday Calendars .................................................................................................................................... 19 

5.5.1     Creating a Holiday Calendar ............................................................................................................. 19 

5.5.2     Editing a Holiday Calendar ................................................................................................................ 21 

5.5.3     Deleting a Holiday from a Holiday Calendar ..................................................................................... 21 

5.5.4     Mass-Deleting Holidays from a Holiday Calendar ............................................................................ 22 

5.5.5     Deleting a Holiday Calendar ............................................................................................................. 24 

5.5.6     Mass-Deleting Holiday Calendars ..................................................................................................... 25 

5.6     Locations .................................................................................................................................................. 27 

5.6.1     Creating a Location ........................................................................................................................... 27 

5.6.2     Editing a Location ............................................................................................................................. 28 

5.6.3     Deleting a Location ........................................................................................................................... 28 

5.7     Pay Codes ................................................................................................................................................. 29 

5.7.1     Creating a Pay Code .......................................................................................................................... 29 

5.7.2     Editing a Pay Code ............................................................................................................................ 29 



 

 

3 

 

5.7.3     Deleting a Pay Code .......................................................................................................................... 30 

5.8     Email Templates ...................................................................................................................................... 31 

5.8.1     Creating an Email Template .............................................................................................................. 31 

5.8.2     Editing an Email Template ................................................................................................................ 34 

5.8.3     Deleting an Email Template .............................................................................................................. 34 

5.8.4     Mass-Deleting Email Templates ....................................................................................................... 36 

5.9     Custom Groups ........................................................................................................................................ 37 

5.9.1     Creating a Custom Group ................................................................................................................. 37 

5.9.2     Editing a Custom Group .................................................................................................................... 38 

5.9.3     Deleting a Custom Group ................................................................................................................. 38 

5.9.4     Mass-Deleting Custom Groups ......................................................................................................... 40 

5.10   Approval Paths ........................................................................................................................................ 41 

5.10.1     Creating an Approval Path .............................................................................................................. 41 

5.10.2     Editing an Approval Path ................................................................................................................ 45 

5.10.3     Deleting an Approval Path .............................................................................................................. 46 

5.11   Company Backup & Restore .................................................................................................................... 47 

5.12   Reset System Cache ................................................................................................................................. 47 

6.0     Employees.................................................................................................................................................... 48 

6.1     Employee Types ....................................................................................................................................... 49 

6.1.1     Creating an Employee Type .............................................................................................................. 49 

6.1.2     Editing an Employee Type ................................................................................................................ 50 

6.1.3     Deleting an Employee Type .............................................................................................................. 50 

6.2     Importing Employees ............................................................................................................................... 51 

6.2.1     Creating a New Employee Import Interface ..................................................................................... 53 

6.3     Employee List ........................................................................................................................................... 54 

7.0     Security ........................................................................................................................................................ 56 

7.1     Security Groups ....................................................................................................................................... 57 

7.1.1     Creating a Security Group ................................................................................................................. 57 

7.1.2     Editing a Security Group ................................................................................................................... 58 

7.2     Permissions .............................................................................................................................................. 58 

7.3     Users ........................................................................................................................................................ 59 

8.0     Setting Up Harmony HR ............................................................................................................................... 61 



 

 

4 

 

8.0.1     Pre-Requisites ....................................................................................................................................... 61 

8.0.2     Recommended Order of Setup ............................................................................................................. 61 

8.1     Import & Export Interfaces ...................................................................................................................... 62 

8.1.1     Creating an Import or Export Interface ............................................................................................ 62 

8.1.2     Editing an Import or Export Interface ............................................................................................... 64 

8.1.3     Deleting an Import or Export Interface ............................................................................................ 64 

8.2     Documents ............................................................................................................................................... 65 

8.2.1     Creating a Folder .............................................................................................................................. 65 

8.2.2     Editing a Folder ................................................................................................................................. 65 

8.2.3     Uploading a Document ..................................................................................................................... 66 

8.2.4     Renaming a Document ..................................................................................................................... 66 

8.2.5     Deleting a Document or Folder ........................................................................................................ 67 

8.2.6     Assigning Documents to Employees ................................................................................................. 67 

8.2.7     Reviewing Acknowledged Documents ............................................................................................. 68 

8.3     Benefits .................................................................................................................................................... 69 

8.3.1     Benefit Vendors ................................................................................................................................ 69 

8.3.2     Benefit Plans ..................................................................................................................................... 71 

8.4     Onboarding .............................................................................................................................................. 76 

8.4.1     Types of Onboarding Steps ............................................................................................................... 76 

8.4.2     Creating an Onboarding Process Record .......................................................................................... 80 

8.4.3     Editing an Onboarding Process Record ............................................................................................ 82 

8.4.4     Deleting a Step in an Onboarding Process Record ........................................................................... 82 

8.4.5     Deleting an Onboarding Process Record .......................................................................................... 83 

8.5     Offboarding .............................................................................................................................................. 84 

8.5.1     Editing the Offboarding Checklist ..................................................................................................... 84 

8.5.2     Editing the Exit Interview.................................................................................................................. 85 

8.6     Competency Groups & Goals ................................................................................................................... 86 

8.6.1     Competency Groups ......................................................................................................................... 86 

8.6.2     Goals ................................................................................................................................................. 89 

8.7     Performance Appraisals ........................................................................................................................... 92 

8.7.1     Creating a Performance Appraisal .................................................................................................... 92 

8.7.2     Editing a Performance Appraisal ...................................................................................................... 94 



 

 

5 

 

8.7.3     Assigning a Performance Appraisal to Employees ........................................................................... 95 

8.7.4     Deactivating/Reactivating a Performance Appraisal ........................................................................ 96 

8.7.5     Deleting a Performance Appraisal .................................................................................................... 96 

8.8     Skills ......................................................................................................................................................... 97 

8.8.1     Creating a Skill .................................................................................................................................. 97 

8.8.2     Editing a Skill ..................................................................................................................................... 97 

8.8.3     Assigning a Skill ................................................................................................................................. 98 

8.8.4     Deleting a Skill .................................................................................................................................. 99 

8.9     Training .................................................................................................................................................. 100 

8.9.1     Creating a Training Course ............................................................................................................. 100 

8.9.2     Editing a Training Course ................................................................................................................ 102 

8.9.3     Assigning a Training Course to Employees ..................................................................................... 103 

8.9.4     Deleting a Training Course .............................................................................................................. 104 

8.10    Company Preferences .......................................................................................................................... 105 

8.11   Employee Preferences ........................................................................................................................... 106 

8.11.1   General ........................................................................................................................................... 107 

8.11.2   Citizenship ...................................................................................................................................... 108 

8.11.3   Company Property.......................................................................................................................... 109 

8.11.4   Employee Contacts ......................................................................................................................... 111 

8.11.5   Documents ..................................................................................................................................... 113 

8.11.6   Employment History ....................................................................................................................... 114 

8.11.7   Professional Memberships ............................................................................................................. 118 

8.11.8   Skills ................................................................................................................................................ 120 

8.12   Notifications .......................................................................................................................................... 121 

8.12.1   Enabling/Disabling a Notification ................................................................................................... 121 

8.12.2   Selecting an Email Template for a Notification .............................................................................. 122 

8.12.3   Choosing to Whom a Notification is Sent....................................................................................... 123 

9.0     Using Harmony Human Resources ............................................................................................................ 124 

9.1     Your Administrative Dashboard ............................................................................................................ 124 

9.1.1     Announcements.............................................................................................................................. 125 

9.1.2     Upcoming Dates ............................................................................................................................. 127 

9.1.3     Time Off Taken ............................................................................................................................... 129 



 

 

6 

 

9.1.4     Notepad .......................................................................................................................................... 129 

9.2     Employees.............................................................................................................................................. 130 

9.2.1     Employee List .................................................................................................................................. 130 

9.2.2     Onboarding ..................................................................................................................................... 134 

9.2.3     Offboarding ..................................................................................................................................... 137 

9.3     Employee Development ........................................................................................................................ 140 

9.3.1     Goals ............................................................................................................................................... 140 

9.3.2     Performance Appraisals .................................................................................................................. 143 

9.3.3     Training ........................................................................................................................................... 146 

9.4     Reporting ............................................................................................................................................... 150 

9.4.1     Available Reports ............................................................................................................................ 150 

9.4.2     Opening a Report ............................................................................................................................ 150 

9.4.3     Editing a Report .............................................................................................................................. 151 

9.4.4     Saving a Report ............................................................................................................................... 152 

9.4.5     Exporting a Report .......................................................................................................................... 153 

9.4.6     Deleting a Report ............................................................................................................................ 154 

Contact Paymate Support ................................................................................................................................... 155 

Paymate Knowledge Base ............................................................................................................................... 155 

Paymate’s YouTube Channel ........................................................................................................................... 155 

 

  



 

 

7 

 

Common Icons and Symbols 
Refer to the table below for common icons, buttons, and symbols that are used throughout the Harmony 

application and user manual.  

Icon / Symbol Description 

 
Menu button. Click this button to shrink or expand the navigation menu. You may also see 
this symbol when reordering items in a section. 

 
Save button. Click this button to save all your changes for the current page. 

 
Delete button. Click this button to delete the item from the database. 

 
Module navigation button. Click this button to view your available modules.  

  
Maximize/minimize button. Click this button to view Harmony in full screen or minimized. 

  

Notifications. Click this button to view your notifications. A red bubble will appear if you 
have notifications, with the number of unread notifications.  

  Toggle. Click this toggle to activate/deactivate an item. 

 Send button. Click this button to send the item for approval.  

 
Refresh button. Click this button to refresh your selection. 

  
Add or remove button. Click on this button to add or remove a field.  

 View button. Click on this button review the record.  

 Edit button. Click on this button to edit the field.  

  
Checkboxes. Click it to check or uncheck the box. 

 
Date icon. Click the field with this icon to select a month and date.  

 Time icon. Click the field with this icon to select a time.  

 
Filter button. Click this button to view available filters for the data on the page.  

 Print button. Click this button to print the item. 

 
Download button. Click this button to download the item. It will automatically be 
downloaded to your browser’s default downloads folder. 

 Search icon. Use the search bar to search for specific items or employees. 

 
Warning message. It will notify you that you should proceed with caution.  

 
Helpful tip message. It will provide you with suggestions, recommendations, or tips. 

‘Dropdown’ Dropdown field options that can be selected will be bolded and in single quotation marks.  

‘Tab’ Tabs within a window that can navigated to will be in single quotation marks. 

“Button” Buttons will be bolded and in double quotation marks. 

“Radio” Radio field options that can be selected will be italicized and in double quotation marks. 

“Field” Fields will be italicized, underlined, and in double quotation marks. 
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Welcome to Harmony 
Thank you for selecting Harmony as your Human Resources (HR) solution. Harmony’s user interface was 

developed with the best technology in the market, so you can easily use the application, no matter where you 

are. Considering both the basic and advanced features of Harmony HR, we recommend that you visit Paymate’s 

knowledge base to view our comprehensive articles and watch our how-to videos to get the most out of 

Harmony. You can also email Paymate support at support@paymatesoftware.com if you require additional help 

or have any specific questions. 

About Harmony Human Resources 
Harmony is a hosted application available for the U.S. and Canada. The hosted nature of this software means all 

your data is stored on the cloud for easy access. You can access it with any browser, including Microsoft Edge, 

Mozilla Firefox, Google Chrome, Safari, and more. Harmony conveniently lets you add and access an unlimited 

number of companies with a single login. Due to its modular nature, Harmony works well with a single module 

or with all its modules, including Payroll, T&A, Human Resources (HR), and Employee Self-Service (ESS). 

Harmony HR helps you easily track time yet still provides the core functions you need, all in a single place. From 

providing options to track time off, manage training courses, administering performance appraisals, and 

onboarding/offboarding employees, Harmony HR is the perfect solution for you. 

About This User Manual 
This guide will outline the process of implementing the Human Resources module for a new company in 

Harmony, as well as provide an understanding of how to use the system as a user. Be aware that this user manual 

will outline all super-administrative user functionality. This manual is not intended for users with limited or 

restricted permissions.  

Throughout this guide, Human Resources will be abbreviated to “HR”. When corresponding with Paymate, this 

abbreviation may be used. Throughout the setup, any field that is required will have the field underlined in red, 

indicating that it must be filled. Once the field is filled, the red underline will disappear. This will be important to 

understand how to properly set up HR with all the required information. 

Software Version 
v1.52.6 

 

This user manual is not updated for every version. Please review Paymate’s release notes for the 
latest features and announcements. 

  

mailto:support@paymatesoftware.com


 

 

9 

 

1.0     Logging In 
Paymate will provide you with your user credentials and URL to access Harmony. These credentials belong to 

the administrative account and will have the widest permissions available.  

1. Copy the Harmony URL that was provided to you.  

2. Open your web browser and paste the URL to navigate to Harmony.  

3. Enter your credentials.  

4. Click “Login”.  

 

The administrative user account has the highest access level of all user accounts in the software. It 
is the ONLY user account that can add or delete other user accounts in Harmony. If you do not have 
your credentials to log into Harmony, please contact Paymate. 

 

5. Select your company.  

6. Click “Select” to log into the selected company. You will be brought to the module selection screen. 
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2.0     Selecting a Module 
Upon logging in, you will be able to select a module. Purchased modules are shown at the top with blue icons, 

while modules that are available with any module of Harmony are shown at the bottom with grey icons.  

• Human Resources includes features such as onboarding, offboarding, document management, training, 

performance management, time off/PTO/absence management, and more. 

• Time & Attendance includes features such as time tracking, time off/PTO/absence management, 

overtime rules, rounding rules, and more.  

• Employee Self-Service includes employee self-help options, including access to their own paystubs 

and/or tax forms, requesting time off/PTO, updating their own profile and contact information, and 

more. 

• Employees are where your employees will be listed. You can create new employees or update existing 

employee information in this section.  

• Security is where you will create user accounts to access the system, as well as update or modify any 

permissions/rights for these user accounts.  

• Settings are where you set up the company’s preferences and basic configuration of your company.  

 

 

Depending on what modules you have purchased, the modules shown on the module selection 
screen may differ from the screenshot provided above. If you have purchased specific modules but 
do not see them in your module selection screen, please contact Paymate Support.  

3.0    Upgrading Your Database 
Because Harmony is hosted on Microsoft Azure, you will receive notifications when there are new updates 

available. When a new version of Harmony is available, you will receive a message that prompts you to update 

your company database version upon logging in. Just click “Update” and Harmony will update your database 

automatically. You may also view the release notes by clicking on the “What’s New?” link.  
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4.0     Navigating Through Harmony 
Navigating around Harmony is simple. The navigation bar on the left side of your screen allows you to flow from 

one page to another easily. Icons will help you quickly identify what section you’re looking for, such as the 

dashboard, the employee list, employee development, or the setup. Sub-menus can also be found, even if you 

are using the collapsed version of the navigation menu. You can click the Menu button at the top of the 

application to collapse or expand the navigation menu. 

The screenshots below depict the navigation menu for HR, but the same layout is used in all modules. 

 

Depending on the permissions that your system administrator has set up for your user account, not 
all navigation items may be visible to you.  
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5.0     Basic Company Configuration 
From the module selection screen, navigate to Settings.  

5.1     Setup  
From the module selection screen, navigate to Settings. The Setup is where your company’s main information is 

set up. These components must be completed first before you can properly use the HR module.  
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5.2     Company Information 
This is where you can enter your company’s legal information.  

1. Navigate to Setup > Company.  

2. Enter your company’s details in the fields under Company Details.  

Field Name Description 

“Company Name” Your company’s legal entity name.  

“Address” 
Your company’s main address. The second line can be used for the suite 
or unit of the address, if any.  

“City” Your company’s city for the main address.  

“Postal Code” Your company’s postal or ZIP code for the main address.  

“Country” Your company’s country for the main address. 

“Province/State” Your company’s province, state, or territory for the main address. 

“Company Phone” Your company’s phone number.  

“Extension” Your company’s extension at the phone number, if any.  

“Fax” Your company’s fax number.  

“Company Email” Your company’s main email address.  

“Company Website” Your company’s main website. 

 

 

3. Enter the primary contact person’s information under Contact Person.  

Field Name Description 

“First Name” The first name or given name of the company’s main contact.  

“Last Name” The last name or surname/family name of the company’s main contact. 

“Position” The contact person’s job title.  

“Telephone” The contact person’s phone number.  

“Extension” The contact person’s extension at their phone number, if any. 
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4. Click the save button to save your changes. 

5.3     Preferences 
Your Preferences will set the default selections and formatting rules for the rest of Harmony.  

1. Navigate to Setup > Preferences.  

2. Enter the required fields under System Settings. These will be the formatting rules for the application. 

Field Name Description 

“Date Format” 
The formatting of dates, such as date of birth, in the system. “M” refers to 
the month, “D” refers to the date, and “Y” refers to the year. 

“Name Display Format” The formatting of employee names in the system.  

“Default Holiday Calendar” The default holiday calendar of which your employees will be assigned to. 

“Fiscal Year” The fiscal year for your company. This affects items such as time off.  

“Two Factor Authentication” 
Enable/disable two-factor authentication for the current user that is logged 
in. If enabled, the user will receive an email with a code in order to log into 
Harmony, as an extra layer of security.  

 

 

3. Enter the required fields under Employee Settings. These will be the default settings whenever you 

create a new employee, which you can also override later.  

Field Name Description 

“Default Country” 
Identifies the employee’s country. If you mainly have employees in a 
single country, you can select it here.  

“Default Province / State” 
Identifies the employee’s province, state, or territory. If you mainly have 
employees in a single province/state, you can select it here.  
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“Default Time Zone” 
Identifies the employee’s time zone. If you mainly have employees in a 
single time zone, or if your organization operates in a particular time 
zone, you can select it here.  

“Default Department” Identifies the employee’s department.  

“Default Location” Identifies the employee’s location. 

 

 

4. Click the save button to save your changes. 
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5.4     Departments 
You can group your employees by Departments for use of pulling up reports or separating your general ledger 

in the Payroll module. 

5.4.1     Creating a Department 

1. Navigate to Setup > Departments.  

2. Click “+ New” to create a new department.  

 

 

Harmony supports multi-tiered departments. If you’d like to create a sub-department, click the “+” 
button on the preceding (parent) department instead.   

3. Enter the required fields.  

Field Name Description 

“Code” Unique ID for the department, such as a short name.  

“Name” The name of the department. 

“Supervisor” 
Identifies the department supervisor or manager. The employee must 
have “Is a manager” ticked in their employee profile.  

“Description” An optional field to provide more information about the department.  

 

 

4. Click the save button to save your changes.  
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5.4.2     Editing a Department 

1. From the list of departments, select the department you want to edit.  

 

2. Edit the fields as required.  

3. Click the save button to save your changes. 

5.4.3     Deleting a Department 

 

If the department is already assigned to an employee, you cannot delete the department. You must 
assign the employee(s) to another department before attempting to delete it.   

1. From the list of departments, select the department you want to delete.  

2. Click the delete button to delete the department.  
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3. Harmony will ask for your confirmation that you want to delete the department. Click “Delete” to delete 

the department. The department is now deleted.  

 

 
If you accidentally deleted a department, you can re-create the department manually.  
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5.5     Holiday Calendars 
Your holiday calendars will directly impact most of the modules you purchase, including Payroll, Human 

Resources, and Time & Attendance. The dates in your holiday calendar will be relevant when your employees 

request time off or the Upcoming Dates in your HR dashboard.  

5.5.1     Creating a Holiday Calendar 

1. Navigate to Setup > Holiday Calendars.  

2. Click “+ New” to create a new holiday calendar.  

 

3. Enter the required fields.  

Field Name Description 

“Name” The name of the holiday calendar. 

“Country” The country of which the holiday calendar is for.  

“Province” The province, state, or territory of which the holiday calendar is for. 

 

 

4. Click “+ Add Holiday” to add a holiday into the holiday calendar.  
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5. Enter the required fields.  

Field Name Description 

“Name” The name of the holiday.  

“Date” The date of the holiday.  

“Non-Statutory Holiday” Identifies if the holiday is a non-statutory holiday.  

“Half Day” Identifies if the holiday is a half day rather than a full day. 

“Description” An optional field to provide more information about the holiday. 

 

 

6. Click the save button to save your changes. 

7. Repeat steps 4 through 6 for each holiday in the calendar.  

8. Click the save button to save your changes to the holiday calendar. 

9. Repeat steps 2 through 8 for each province, state, or territory of which you have employees in. 

 

Harmony includes a “Fetch Holidays” option in which the system will fetch the 
province/state/territory’s federal holidays according to your selected country and 
province/state/territory. Ensure that you enter a year prior to fetching to correctly use this feature.    

 

 

Once the holiday calendars are set up, you must assign them to the respective employees in the 
T&A module after you’ve set up your employees.  
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5.5.2     Editing a Holiday Calendar 

1. From the list of holiday calendars, select the holiday calendar you want to edit.  

 

2. Edit the holiday calendar as required. 

3. Click the save button to save your changes.  

5.5.3     Deleting a Holiday from a Holiday Calendar 

1. From the list of holiday calendars, select the holiday calendar you want to delete a holiday from.  

 

2. From the list of holidays, select the holiday you want to delete.  
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3. Click the delete button to delete the holiday.   

 

4. Harmony will ask for your confirmation that you want to delete the holiday. Click “Delete” to delete the 

holiday. The holiday is now deleted.  

 

 
If you accidentally deleted a holiday, you can re-create the holiday manually.  

5.5.4     Mass-Deleting Holidays from a Holiday Calendar 

1. From the list of holiday calendars, select the holiday calendar you want to delete a holiday from.  

 

2. From the list of holidays, use the checkboxes to select the holidays you want to delete.  
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3. Click the delete button to delete the selected holidays.  
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4. Harmony will ask for your confirmation that you want to delete the selected holidays. Click “Delete” to 

delete the selected holidays.   

 
If you accidentally deleted a holiday, you can re-create the holiday manually.  

5.5.5     Deleting a Holiday Calendar 

 

If the holiday calendar is already assigned to an employee, you cannot delete the holiday calendar. 
You must assign the employee(s) to another holiday calendar before attempting to delete it.   

1. From the list of holiday calendars, select the holiday calendar you want to delete.  

2. Click the delete button to delete the holiday calendar.  

 

3. Harmony will ask for your confirmation that you want to delete the holiday calendar. Click “Delete” to 

delete the holiday calendar. The holiday calendar is now deleted.  
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If you accidentally deleted a holiday calendar, you can re-create the holiday calendar manually.  

5.5.6     Mass-Deleting Holiday Calendars 

1. From the list of holiday calendars, use the checkboxes to select the calendars you want to delete.  

 

2. Click the delete button to delete the selected holiday calendars.  

 

3. Harmony will ask for your confirmation that you want to delete the selected holiday calendars. Click 

“Delete” to delete the selected calendars.  
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If you accidentally deleted a holiday calendar, you can re-create the holiday calendar manually.  
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5.6     Locations 
You can group your employees by Locations for use of pulling up reports or separating your general ledger in the 

Payroll module. 

5.6.1     Creating a Location 

1. Navigate to Setup > Locations.  

2. Click “+ New” to create a new location.  

 

 

Harmony supports multi-tiered locations. If you’d like to create a sub-location, click the “+” button 
on the preceding (parent) location instead.   

3. Enter the required fields.  

Field Name Description 

“Code” Unique ID for the location, such as a short name.  

“Name” The name of the location. 

“Description” An optional field to provide more information about the location.  

 

 

4. Click the save button to save your changes.  
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5.6.2     Editing a Location 

1. From the list of locations, select the location you want to edit.  

 

2. Edit the fields as required.  

3. Click the save button to save your changes. 

5.6.3     Deleting a Location 

 

If the location is already assigned to an employee, you cannot delete the location. You must assign 
the employee(s) to another location before attempting to delete it.   

1. From the list of locations, select the location you want to delete.  

2. Click the delete button to delete the location.  

 

3. Harmony will ask for your confirmation that you want to delete the location. Click “Delete” to delete 

the location. The location is now deleted.  

 

 
If you accidentally deleted a location, you can re-create the location manually.  
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5.7     Pay Codes 
Pay codes are the links to Payroll from the other modules. You can import or set these up to assign to particular 

sections of each module, such as projects/tasks, time off types, benefits, and more.  

5.7.1     Creating a Pay Code 

1. Navigate to Setup > Pay Codes.  

2. Click “+ New” to create a new pay code.  

 

3. Enter the required fields.  

Field Name Description 

“Code” Unique ID for the pay code, such as a short name.  

“Name” The name of the pay code.  

“Description” An optional field to provide more information about the pay code.  

 

 

4. Click the save button to save your changes.  

5. Repeat steps 2 through 4 for each pay code.  

 

Harmony includes a “Fetch” option in which the system will fetch your existing pay codes (payroll 
categories) from the Payroll module.     

5.7.2     Editing a Pay Code 

1. From the list of pay codes, select the pay code you want to edit.  

2. Edit the pay code as required. 

3. Click the save button to save your changes.  
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5.7.3     Deleting a Pay Code 

 

If the pay code is already assigned to an item in any module, you cannot delete it. You must assign 
the item to a different pay code before attempting to delete it. You will also not be able to delete a 
pay code that was fetched from the Payroll module. 

1. From the list of pay codes, select the pay code you want to delete.  

2. Click the delete button to delete the pay code.  

 

3. Harmony will ask for your confirmation that you want to delete the pay code. Click “Delete” to delete 

the pay code. The pay code is now deleted.  

 

 
If you accidentally deleted a pay code, you can re-create the pay code manually.  
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5.8     Email Templates 
Your email templates are used to send email notifications when certain events are triggered in Harmony. For 

example, when your employees request time off, you can receive an email notifying you to log in and approve 

or reject the time off request.  

5.8.1     Creating an Email Template 

1. Navigate to Setup > Email Settings.  

2. Click “+ New” to create a new email template.  

 

3. Enter the required fields.  

Field Name Description 

“Name” The name of the email template.  

“Description” An optional field describing the email template.  

“Subject” The subject of the email that you will receive for the notification. 

“Body” The body of the email that you will receive for the notification. 
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4. For the “Body” of the email, you can use the dynamic placeholders to personalize the message. These 

placeholders will be replaced when the email notification is emailed. You can also use the available 

formatting tools to customize your message, such as bold, italics, fonts, and more.  

Placeholder Name Description 

Announcement Name The title of the announcement made in the HR module.  

Announcement Body/Text The body of the announcement made in the HR module. 

Announcement Post Date The date that the announcement was posted in the HR module.  

Approver First Name The first name or given name of the approver. 

Approver Last Name The last name, surname, or family name of the approver. 

Clock In Time The time that the employee clocked in, from the T&A module.  

Clock Out Time The time that the employee clocked out, from the T&A module. 

Clock Entry Duration The duration of time the employee clocked in for, from the T&A module. 

Competency Group Name The name of the competency group from the HR module. 

Current Date The current date of which the email is sent.  

Current Time The current time of which the email is sent.  

Employee First Name The first name or given name of the employee. 

Employee Last Name The last name, surname, or family name of the employee.  

Employee Home Department The department that the employee is assigned to. 

Employee Home Location The location that the employee is assigned to. 

Employee Work Permit Expiry 
Date 

The expiry date of the employee’s work permit, as defined in the HR 
module. 

Employee Contract End Date The end date of the employee’s contract, as defined in the HR module. 

Employee Probation End Date 
The end date of the employee’s probationary period, as defined in the 
HR module. 

Employee Professional 
Membership Renewal Date 

The date of which an employee’s professional membership must be 
renewed, as defined in the HR module.  

Employee Professional 
Membership Organization 

The organization that provides the professional membership of which 
the employee is a part of, as defined in the HR module. 

Employee Professional 
Membership Type 

The type of professional membership that the employee is a part of, as 
defined in the HR module. 

Employee Professional 
Membership Designation Name 

The name or designation of the professional membership that the 
employee is a part of, as defined in the HR module. 

Employee Profile Section The section of the employee profile, as per the HR module. 

Employee Shift Code 
The code of the shift of which the employee works, as defined in the T&A 
module. 

Employee Shift Name 
The name of the shift of which the employee works, as defined in the 
T&A module. 

Goal Name The name of the goal, as defined in the HR module.  

Goal Creation Date The date of which the goal was created, as defined in the HR module.  

Goal Expiry Date The expiry date of the goal, as defined in the HR module. 

Goal Progress The percentage of progress made on a goal, as defined in the HR module. 

Offboarding Checklist Item Name The name of the offboarding checklist item, as defined in the HR module. 

Offboarding Checklist Item Expiry 
Date 

The date of which an offboarding checklist item must be completed by, 
as defined in the HR module. 

Onboarding Link 
The link that new hires will receive when onboarded, as defined in the 
HR module.  
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Onboarding Employee Name The name of the new hire, as defined in the HR module.  

Performance Review Name The name of the performance review, as per the HR module.  

Performance Review Instructions 
The instructions provided in the performance review, as per the HR 
module. 

Performance Review Start Date The date of which a performance review begins, as per the HR module.  

Recipient First Name 
The first name or given name of the person receiving the email 
notification. 

Recipient Last Name 
The last name, surname, or family name of the person receiving the email 
notification. 

Time Off Request Date Range The date range of the time off request, as per the T&A or HR modules. 

Time Off Request Time Ranger The time range of the time off request, as per the T&A or HR modules. 

Time Off Type of Request The name of the time off type requested, as per the T&A or HR modules. 

Timesheet Date Range The date range of the timesheet, as per the T&A module. 

Timesheet Total Hours The total hours worked in the timesheet, as per the T&A module. 

Timesheet Total Regular Hours 
The total hours of regular time worked in the timesheet, as per the T&A 
module. 

Timesheet Total Overtime Hours 
The total hours of overtime worked in the timesheet, as per the T&A 
module. 

Timesheet Total Time Off Hours 
The total hours of time off taken in the timesheet, as per the T&A 
module. 

Timesheet Total Weekly Hours 
The total hours worked per working week in the timesheet, as per the 
T&A module.  

Timesheet Total Weekly Regular 
Hours 

The total hours of regular time worked per working week in the 
timesheet, as per the T&A module.  

Timesheet Total Weekly Overtime 
Hours 

The total hours of overtime worked per working week in the timesheet, 
as per the T&A module.  

Timesheet Total Weekly Time Off 
Hours 

The total hours of time off taken per working week in the timesheet, as 
per the T&A module.  

Training Event Name The name of the training event, as per the HR module.  

Training Event Start Date The start date of the training event, as per the HR module. 

Training Event End Date The end date of the training event, as per the HR module.  

Training Event Trainer The trainer for the training event, as per the HR module.  

Training Event Room The room or location for the training event, as per the HR module.  

Training Event Instructions The instructions set for the training event, as per the HR module.  

User Name The username of the user (email address used to log into Harmony).  

Password The password of the user that is used to log into Harmony.  

Company The company of which the user has access to in Harmony.  

 

5. Click the save button to save your changes.  

 

After you’ve created all your email templates, you will need to assign them to the corresponding 
notification in each module that you’ve purchased. You can do this by navigating to the module and 
going to Setup > Notifications.      
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5.8.2     Editing an Email Template 

1. From the list of email templates, select the template you want to edit.  

 

2. Edit the fields as required.  

3. Click the save button to save your changes.  

5.8.3     Deleting an Email Template 

 

If the email template is already assigned to a notification in any module, you cannot delete it. You 
must assign the notification to a different email template before attempting to delete it.  

1. From the list of email templates, select the email templates you want to delete.  

2. Click the delete button to delete the email template.  
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3. Harmony will ask for your confirmation that you want to delete the email template. Click “Delete” to 

delete the email template. The email template is now deleted.  

 

 
If you accidentally deleted an email template, you can re-create it manually.  
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5.8.4     Mass-Deleting Email Templates 

 

If the email template is already assigned to a notification in any module, you cannot delete it. You 
must assign the notification to a different email template before attempting to delete it.  

1. From the list of email templates, use the checkboxes to select the email templates you want to delete.  

 

2. Click the delete button to delete the selected email templates.  

 

3. Harmony will ask for your confirmation that you want to delete the selected email templates. Click 

“Delete” to delete the email templates. The email templates are now deleted.  

 

 
If you accidentally deleted an email template, you can re-create it manually.  
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5.9     Custom Groups 
Custom groups are used to group your employees if they cannot be grouped by other fields in Harmony. For 

example, employees can be grouped by their departments, but you use custom groups to group all your 

department managers together. This will be used to identify your approval paths later on.  

5.9.1     Creating a Custom Group 

1. Navigate to Approval Path > Custom Groups.  

2. Click the “+ New” button to create a new custom group.  

3. Enter the required fields.  

Field Name Description 

“Code” Unique ID for the custom group, such as a short name.  

“Name” The name of the custom group.  

“Description” An optional field to provide more information about the custom group.  

 

 

4. In the Employees section, you can use the filters and/or search bar to search for a particular employee. 

Click the checkbox of the employee on the left side and click the “→” button to move them into this 

custom group. To remove an employee from this group, you can select the employee on the right side 

and click the “” button instead.  

 

Employees can only belong to one custom group at a time. If an employee already belongs to a 
custom group, Harmony will indicate this in the list of employees. Moving them to the current group 
will automatically remove them from their previous group.       

5. Click the save button to save your changes.  
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5.9.2     Editing a Custom Group 

1. From the list of custom groups, select the group you want to edit.  

 

2. Edit the fields as required.  

3. Click the save button to save your changes.  

5.9.3     Deleting a Custom Group 

 

If an employee is already assigned to a custom group, you cannot delete it. You must assign the 
employee to a different custom group before attempting to delete it.  

4. From the list of custom groups, select the group you want to delete.  

5. Click the delete button to delete the custom group.  
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6. Harmony will ask for your confirmation that you want to delete the custom group. Click “Delete” to 

delete the custom group. The custom group is now deleted.  

 

 
If you accidentally deleted a custom group, you can re-create it manually.  
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5.9.4     Mass-Deleting Custom Groups 

 

If an employee is already assigned to a custom group, you cannot delete it. You must assign the 
employee to a different custom group before attempting to delete it.  

1. From the list of custom groups, use the checkboxes to select the custom groups you want to delete.  

 

2. Click the delete button to delete the selected custom groups.  

 

3. Harmony will ask for your confirmation that you want to delete the selected custom groups. Click 

“Delete” to delete the custom groups. The custom groups are now deleted.  

 

 
If you accidentally deleted a custom group, you can re-create it manually.  
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5.10   Approval Paths  
Approval paths are used to identify who oversees approving items in each module, such as timesheet, benefit 

enrollments, and time off requests. Multiple approval paths can be set for different departments, locations, 

shifts, or personnel.  

 

Items requiring approval will remain with the same approval path at the time that the item was 
requested or submitted. If employees change approval paths, it will not affect items that were 
already submitted or approved. The item must be rejected or cancelled for the new approval path 
to take effect.  

5.10.1     Creating an Approval Path 

1. Navigate to Approval Path > Approval Path.  

2. Click the “+ New” button to create a new approval path.  

 

3. Enter the required fields.  

Field Name Description 

“Code” Unique ID for the approval path, such as a short name.  

“Name” The name of the approval path.  

“Description” An optional field to provide more information about the approval path.  

“Module Components” 
The sections of each module for which this approval path will apply to. 
You may select more than one if applicable.  

 

 

4. In the Approval Sequence section, this is where you will identify the approvers for this approval path. 

They will be approvers of the module components that you selected earlier. If you want to send 

reminders if no action has been taken once a request has been submitted, you can use the checkbox 

and enter the number of hours. The reminders will be sent to whoever is in the dropdown in the grid 

below.  

5. Click the “+” button to add a new approval sequence.  
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6. Select/enter the required fields.  

Field Name Description 

“Sequence” 

The sequence of which the approvers will approve the request. If you 
have more than one sequence, then at least one approver of each 
sequence must approve the request before it can be moved onto the 
next sequence of approvers.  

“Approver 1” The first approver of the sequence.  

“Approver 2” The second approver of the sequence.  

“Reminder” The user of which the reminders will go to, related to step #4 above. 

 

There are toggles for each approver in each sequence. Ensure that you toggle this on to activate the 
approver for the sequence, to allow them to be the approver. If this is not toggled on (deactivated), 
then the approver will not be able to approve the request. If both approvers are active, then either 
one of the approvers may approve the request in order for it to move onto the next sequence. 

 

7. In the Approval Criteria section, this is where you will identify to whom this approval path will apply to. 

For example, if this approval path is only applicable to those in a particular location or department, or if 

it’s applicable to a specific person, this can be identified in this area. There will already be one criterion 

that you enter, but you may add additional ones if required.  

8. Enter the required fields.  

Field Name Description 

“Criterion” 

The name of the criteria of which will apply to this approval path. 
Available selections include:  

• Main Shift – The shift of which the employee is assigned to, as 
per the T&A module.  

• Worked Shift – The shift of which the employee works (only 
applicable if the employee is assigned to more than one shift), as 
per the T&A module.  

• Location – The location of which the employee is assigned to.  

• Department – The department of which the employee is 
assigned to.  

• Employee ID – A specific employee.  
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• Timesheet Period – The timesheet period of which the employee 
is assigned to, as per the T&A module.  

• Custom Group – The custom group of which the employee is 
assigned to, if any.  

“Selection” 
The selection according to the criterion that you selected. For example, 
if you selected “Department” as your criterion, a list of all your 
departments will appear for you to select.  

 

There are toggles for each approver in each sequence. Ensure that you toggle this on to activate the 
approver for the sequence, to allow them to be the approver. If this is not toggled on (deactivated), 
then the approver will not be able to approve the request. If both approvers are active, then either 
one of the approvers may approve the request in order for it to move onto the next sequence. 

 

9. Click the “+ Add Criteria” button to add new criterion for the approval path.  

 

10. If you’ve entered more than one criterion for the approval path, click the edit button to edit the criteria 

pattern.  

 

11. Use the tiles available to drag and drop your criteria pattern, similar to a mathematical expression.  

Available Tiles Description 

“AND” 
Provides a pattern of an ‘and’ scenario. For example, if you have the criteria pattern: 
Department AND Location, then this means that the employe must be assigned to both that 
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particular department and that particular location. Employees of the selected department 
but of a different location will not apply, and vice versa.  

“OR” 
Provides a pattern of an ‘or’ scenario. For example, if you have the criteria pattern: 
Department OR Location, then this means that the employee must be either assigned to that 
particular department or that particular location – but not both.  

“(“, “)” 

Open and end parentheses, otherwise known as brackets. Use this option when you want 
to use this part of the criteria pattern first. For example, if you have the criteria pattern: 
(Department AND Location) OR Employee ID, then this means that the employee must be 
assigned to both that particular department and location, but there is an exception – if that 
employee is the selected employee of that third criterion.  

 

 
12. Click the “TEST” button to test your criteria and criteria pattern for the approval path.  

 

Keep in mind that approval paths are ordered in a particular order (most specific to least specific, as 
per step #13 below), so even if the correct employees appear when you are testing the approval 
path, it is important to make sure that they are ordered correctly. You can double-check this by 
navigating to Approval Path > Assigned Approval Paths later.  

 

13. Click the save button to save your changes.  

14. In the list of all approval paths, these must be ordered in a particular order. The most specific approval 

paths should appear at the top of the list, while the most generic approval paths should appear at the 

bottom of the list. You can use the menu button to reorder the list as required. Generally, the order of 

the approval paths (according to the criteria selected) should be: Employee ID, Custom Group, Worked 

Shift, Main Shift, Timesheet Period, Department, Location.  

 

The system provides a default approval path for you as a catch-all for any requests that do not apply 
to any of your approval paths. This default approval path will not have any criteria, and is strongly 
recommended to be at the bottom of your list of approval paths. 
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15. Navigate to Approval Path > Assigned Approval Paths to double-check if your employees are assigned to 

the correct approval paths. You can use the filter/parameters at the top of the page to search for an 

employee or select the module component for the approval path.  

 

5.10.2     Editing an Approval Path 

 

Items requiring approval will remain with the same approval path at the time that the item was 
requested or submitted. If employees change approval paths because you modified any criteria or 
approvers, it will not affect items that were already submitted or approved. The item must be 
rejected or cancelled for the new approval path to take effect.  

1. From the list of approval paths, select the approval path you want to edit.  

 

2. Edit the approval path as required.  

3. Click the save button to save your changes.  
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5.10.3     Deleting an Approval Path 

 

If the approval path is already assigned to an employee, you cannot delete it. You must assign the 
employee to a different approval path before attempting to delete it.  

1. From the list of approval paths, select the approval path you want to delete.  

2. Click the delete button to delete the approval path.  

 

3. Harmony will ask for your confirmation that you want to delete the approval path. Click “Delete” to 

delete the approval path. The approval path is now deleted.  

 

 
If you accidentally deleted an approval path, you can re-create it manually.  
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5.11   Company Backup & Restore 
While Harmony is a cloud-based solution, you have the ability to create a manual restore point at any time. This 

should be done frequently to have multiple restore points in the system in case information is entered 

incorrectly, and you would like to reverse it.  

 

Each Harmony account, by default, is limited to 1 GB of backup space. If you require additional 
space, feel free to delete any old backups that you will not use any longer, or contact the Paymate 
team to purchase additional space.  

1. Navigate to Tools > Backup/Restore.  

2. Enter the “Back Up File Name”. A default one will already be provided for you.  

3. Click “Back Up” to back up your data.  

 

4. Your backup file will be shown in the table. Click the restore button to restore a backup if required.  

 

It is strongly recommended that you make a backup prior to restoring a backup if you restore the 
incorrect one. You must also ensure that no one is using the system when you restore a backup, as 
this will bring your data back in time – thus no information entered after creating the backup will be 
saved. This means any employees who are currently clocked in may not be clocked in any longer. 

5.12   Reset System Cache 
As Harmony is a web-based system, resetting your browser and system cache will help clear old data in the event 

something is not showing or working properly.  

 
We recommend clearing your system and browser’s cache after there is a new update.  

1. Navigate to Tools > System Tools.  

2. Click “Reset System Cache”.  
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6.0     Employees 
All modules of Harmony share a common database – which means your employees, when entered once, will 

be available in all modules. From the module selection screen, select Employees.  
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6.1     Employee Types 
Your employee types must be set up prior to importing employees or creating your employees. This is a way that 

you can use to group your employees, similar to Departments and Locations. Common examples include Full-

Time, Part-Time, Seasonal, Casual, or others.  

6.1.1     Creating an Employee Type 

1. Navigate to Employees > Employee List.  

2. Click “+ New” button to pull up a new employee profile.  

 

3. Beside the field “Employee Type”, click “View All” to view all employee types.  

 

4. Click the “+ New” button to create a new employee type.  

 

5. Enter the required fields.  

Field Name Description 

“Code” Unique ID for the employee type, such as a short name.  

“Name” The name of the employee type.  

“Description” An optional field to provide more information about the employee type.  

6. Click the save button to save your changes.  

7. Repeat steps 4 and 5 for each employee type.  
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6.1.2     Editing an Employee Type 

1. From the list of employee types, select the employee type you want to edit.  

 

2. Edit the employee type as required. 

3. Click the save button to save your changes.  

6.1.3     Deleting an Employee Type 

 

If the employee type is already assigned to an employee, you cannot delete it. You must assign the 
employee to a different employee type before attempting to delete it.  

1. From the list of employee types, select the employee type you want to delete.  

2. Click the delete button to delete the employee type.  

 

3. Harmony will ask for your confirmation that you want to delete the employee type. Click “Delete” to 

delete the employee type. The employee type is now deleted.  

 

 
If you accidentally deleted an employee type, you can re-create it manually.  
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6.2     Importing Employees 
Employees can be imported into the system using a comma delimited (CSV) file type. You can either use the 

predefined import interface that Harmony provides for you, or create your own to fit the export of any system 

that you are currently using.  

1. Navigate to Employees > Import Employees.  

2. Click “Start” to begin the importing process.  

 

3. Choose your interface.  

a. If you want to use the predefined interface, select either the “EMP_IMP_CAN – Employee 

Import-Canada” interface for customers in Canada, or the “EMP_IMP_USA – Employee Import-

USA” for customers in USA.  

 

b. If you want to create your own, click the “+ New” button. Go to 6.2.1 Creating a New Employee 

Import Interface for more information. After creating your new employee interface, select it.  
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4. Click “Next →” to go to the next step after selecting your interface.  

 

5. Select your file by dragging it from your computer into the allocated box or click the box to browse your 

computer.  

 

6. Click “Import”.  

 

If there is anything wrong with your import file, the system will inform you. Please review and revise 
your import file and try to import again.   
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6.2.1     Creating a New Employee Import Interface 

This is only required if you are looking to create a new import interface for your employees. 

1. Follow steps 1 through 3b from 6.2 Importing Employees if you have not already.  

2. Activate the import interface by switching the toggle.  

 

3. Enter the required fields.  

Field Name Description 

“Code” Unique ID for the employee import interface such as a short name.  

“Name” The name of the employee import interface. 

4. Identify if the import file will have headers or not.  

 

If you identify that your file will have headers, then the system will ignore the first row of your file 
when importing.  

5. Click the “+” button to add a new field into the interface.  

 

6. Enter the required fields.  
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Ensure that all required fields (marked with an asterisk (*)) are selected in your interface. 

Field Name Description 

“Column” 

The column of which this field will be in according to your import file. This 
should only be a numerical value. For example, entering “1” will mean 
that this field will be in the first column, such as column A, of your import 
file. 

“Name” The name of the field of which will be imported.  

“Date Format” 

For date fields, such as date of birth or start date, you must identify the 
dater format, such as “MM/DD/YYYY” where “MM” refers to the two-
digit month (i.e. “02” for February), “DD” refers to the two-digit date (i.e. 
“20” for the 20th of the month), and “YYYY” means the four-digit year (i.e. 
“2024”). 

7. Click the save button to save your changes. 

6.3     Employee List 
You can view your employee list or manually add an employee by going to your Employee List.  

1. Navigate to Employees > Employee List. Your list of employees will be shown here.  
2. To create a new employee, click the “+ New” button.  

 
3. Enter the fields as required.  

Field Name Description 

“First Name” The first name, or given name, of the employee.  

“Middle Name” The middle name of the employee.  

“Last Name” The last name, or the family name or surname, of the employee.  

“Title” The title of the employee, if any.  

“Gender” The gender of the employee.  

“Pronouns” The pronouns for the employee.  

“Date of Birth” 
The date of birth for the employee. You can identify if the date of birth 
was certified or not.   

“Place of Birth” The place of birth for the employee.  

“SIN” The social insurance number for the employee, for Canadian employees. 

“SSN” The social security number for the employee, for US employees.  

“SSN Type” The type of social security number for the employee, for US employees. 

“Marital Status” The marital status of the employee.  

“Home Phone” The home phone for the employee.  

“Cell Phone” The cell or mobile phone for the employee.  

“Personal Email” The personal email address for the employee.  

“Address” The home address for the employee.  
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“Country” The country where the employee resides.  

“Province/State” The province, state, or territory where the employee resides.  

“City” The city or town where the employee resides. 

“ZIP/Postal Code” The ZIP or postal code where the employee resides. 

“Employee ID” The unique employee ID, code, or number for the employee.  

“Job Title” The job title or position of the employee.  

“Employment Status” 
The employment status of the employee. This will contribute to your 
active employee license.  

“Employee Type” 
The employee type for the employee. Review the Employee Types section 
for more information. 

“Start Date” The date of hire for the employee.  

“Termination Date” 
The termination date of the employee, if the employment status is 
inactive or terminated.  

“Last Hire Date” The most recent hire date of the employee, if the employee was rehired. 

“Work Phone” The work phone and extension (if any) of the employee.  

“Work Email” The work email address of the employee.  

“Department” 
The assigned department of the employee. Review the Departments 
section for more information. 

“Work Location” 
The assigned location of the employee. Review the Locations section for 
more information. 

“Supervisor” The supervisor, or manager, of the employee. 

“Alternate Manager” The alternative supervisor, or manager, of the employee. 

“Time Clock UID” A separate user ID for a time clock, if any.  

“Seniority Date” The seniority date for the employee.  

“Is a Manager” 
Identifies if the employee is a manager/supervisor or not. This will allow 
this employee to be selected as another employee’s manager.  

4. Click the save button to save your changes.   
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7.0     Security 
The Security section is where you can provide or prevent access to the system. From the module selection screen, 

select Security.  

 

 

It is strongly recommended that you do not create user accounts to access Harmony until after go-
live of your system. Creating users will automatically send an email to the user with their credentials. 
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7.1     Security Groups 
Your security groups are your groups of users with the same permissions and/or rights. You can have an 

unlimited number of security groups. 

 

You cannot delete security groups once created. You may only deactivate them to prevent access to 
the system from users in these security groups.  

7.1.1     Creating a Security Group 

1. Navigate to Security > Groups.  

2. Click “+ New” to create a new security group.  

 

3. Activate the security group by using the toggle at the top of the window. 

 

If the security group is inactive, then users assigned to that security group will not be able to access 
the system. 

 

4. Enter the required fields.  

Field Name Description 

“Code” Unique ID for the security group, such as a short name.  

“Name” The name of the security group.  

“Copy Security Settings” 
An optional field to copy the security settings from another security 
group. 

5. Click the save button to save your changes.  
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7.1.2     Editing a Security Group 

1. From the list of security groups, select the group that you want to edit.  

 

2. Edit the fields as required.  

3. Click the save button to save your changes. 

7.2     Permissions  
Each security group will have their own unique set of permissions to have limited access to the system.  

1. Navigate to Security > Permissions.  

 

You can also navigate to Security > Groups and select a security group. Then click on “View 
Permissions” to view the permissions for that particular security group. A similar process can be 
followed for viewing the permissions for a particular user.  

2. Select the “Group” filter at the top of the page to select the security group.  

 

3. Update the permissions as required for each “Module” by using the checkboxes. 
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4. Click the save button to save your changes. 

5. You may also navigate to the ‘Data Filters’ section if you want to restrict this security group to only have 

permissions to access a particular department.  

 

7.3     Users  
Users are assigned to each security group to have access to the system.  

 

You cannot delete or modify users once created. You may only deactivate them to prevent access 
to the system.  

1. Navigate to Security > Users. 

2. Click “+ New” to create a new user.  

 

3. Activate the user by using the toggle at the top of the window.  

 
If the user is inactive, then this user will not be able to access the system.   

4. Enter the required fields.  

Field Name Description 

“User Name” 
The user’s username, or email address, that they will use to log into 
Harmony. Ensure that this is a valid email address.  

“Password” 
The user’s password to log into Harmony. Ensure that it meets the minimum 
requirements: At least nine characters with at least one uppercase letter, 
one lowercase letter, one number, and one special character.  

“Confirm Password” Re-type the user’s password to confirm. 
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“Force Change Password” 
Identifies if you want to force the user to change their password upon their 
first login. Otherwise, the user will continue to use the password you 
entered for them until they manually change it.  

“Redirect to Module on Login” 
Identifies which module that the user will be redirected to upon login. If 
redirecting to a module, they will bypass the module selection screen. 

“Link User to Employee” 

Identifies if this user should be linked to an employee profile. This is required 
if you are using the employee self-service module for this user. If you are not 
linking an employee to this user, then this user is not an employee and will 
only have access to view the data in Harmony.  

“Security Group” 
This user’s assigned security group. Review the Security Groups section for 
more information. 

 

 
5. Click the save button to save your changes. 

 

You cannot edit the user once saved. Please ensure that you verify that you are entering the 
username correctly. If you saved the user with the incorrect email address, please contact Paymate 
Support immediately to modify. DO NOT create a new user with the correct email address.  
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8.0     Setting Up Harmony HR 
In the following section are the items you will need to set up for your Human Resources module. In each section, 

the required fields are underlined in red.  

8.0.1     Pre-Requisites  
Aside from Harmony HR, you must have completed the following sections in the configuration of Harmony as 

well. Please refer to the Harmony Company Setup User Manual for more information. 

• Setup > Preferences > Time Zone  

• (optional) Setup > Preferences > Fiscal Year 

 
You will only need to have the fiscal year set up if your time off types will accrue by fiscal year.    

• Setup > Settings > Holiday Calendars  

• Setup > Settings > Pay Codes 

• (optional) Setup > Approval Path > Custom Groups 

• Setup > Approval Path > Approval Paths  

• Setup > Settings > Email Templates & Settings (if sending email notifications) 

8.0.2     Recommended Order of Setup  

 

We highly recommend setting up Harmony HR in the order that we have laid out in the following 
section. Not all sections are required for you to use the module, but following this order will reduce 
the time you spend going back and forth between sections. 

1. Import & Export Interfaces – only required if you will be importing/exporting data from the system 

2. Documents 

3. Benefit Vendors & Plans  

4. Onboarding 

5. Offboarding 

6. Goals & Competency Groups  

7. Performance Appraisals  

8. Training  

9. Time Off Types / Absences / PTO 

10. Company Preferences  

11. Employee Preferences & Configuration  

12. Notifications  
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8.1     Import & Export Interfaces 
Interfaces allow you to import and export files into and out of Harmony in particular formats. Interfaces can be 

created for several types, including Benefit Plans, Employee Contacts, Goals, Performance Appraisals, and 

more. You can only have a maximum of two (2) interfaces per type - one for comma delimited file tyles (.CSV) 

and another for fixed length file types (.TXT). To review your interfaces, navigate to Setup > Interfaces.  

8.1.1     Creating an Import or Export Interface 

1. Click “+ New” to add a new interface.  

2. Enter the required fields.  

Field Name Description 

“Code” A short name for the interface.  

“Name” The name of the interface.  

“For” Identifies if the interface is for importing or exporting data into/from Harmony.   

“Type” Identifies what type of data this interface will import or export.  

“File Type” Identifies the type, either comma delimited (CSV) or fixed length (TXT), of the file.  

“Has Header” 

If ticked, the import/export file will have a header.  

 

If you have a header in your import file, then Harmony will ignore the first row 
of data when you import the file.  

 

“Description” Optional field that describes the interface. 

 

 



 

 

63 

 

3. Depending on the type you selected earlier, there are different fields to select from that can be included 

in your import or export file. The images below will use the type for Employee Contacts.  

 

4. Click the add button to add a row to map a field in the table on the right side of the window. Fields that 

are required to be in your interface are indicated with an asterisk, so be sure that you include these.  

 

5. Click the save button to save your changes. 
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8.1.2     Editing an Import or Export Interface 

1. From the list of interfaces, select the interface you want to edit.  

 

2. Edit the fields as required. 

3. Click the save button to save your changes. 

8.1.3     Deleting an Import or Export Interface 

1. From the list of interfaces, select the interface you want to delete.  
2. Click the delete button to delete the interface.  

 
3. Harmony will ask for your confirmation that you want to delete the interface. Click “Delete” to delete 

the interface. The interface is now deleted.  

 

 
If you accidentally deleted an interface, you can re-create the interface manually.  
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8.2     Documents 
You can easily upload, view, download, and acknowledge documents. Documents can be organized in folders 

and can be assigned to your employees. To review your documents, navigate to Setup > Documents. 

8.2.1     Creating a Folder  

1. Click on the “New Folder” button at the top-right corner to create a new folder.  

 

2. Enter the required fields.  

Field Name Description 

“Name” The name of the folder.  

3. Click the “Save” button to save your changes.  

 

8.2.2     Editing a Folder  

1. In the list of documents and folders, click the “Edit” button for the folder you want to edit.  

 

2. Edit the fields as required. 

3. Click on the “Save” button to save your changes. 
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8.2.3     Uploading a Document 

1. Click on the “Upload” button to upload a new document.  

 

2. Drag a document from your computer into the designated area in the pop-up window or click the box 

to browse your computer for a document.  

 

3. After you’ve selected a document, enter the required fields.  

Field Name Description 

“Name” The name of the document.  

“Folder” Identifies the folder that the document belongs to. If you don’t select a folder, it won’t 
belong to a folder and will appear in an ‘empty’ folder at the top of the list of documents. 

4. Click the “Upload” button to finish your upload.  

 

If you accidentally uploaded a document to the incorrect folder, you can drag and drop the 
document to the correct folder. 

8.2.4     Renaming a Document 

1. In the list of documents, click the “Edit” button for the document you want to rename.  

 

2. Edit the fields as required. 

3. Click the “Save” button to save your changes. 
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8.2.5     Deleting a Document or Folder  

1. From the list of documents or folders, select the “Delete” button next to the document or folder that 

you want to delete.  

 

2. Harmony will ask for your confirmation that you want to delete the document or folder. Click “Delete” 

to delete the document or folder. The document or folder is now deleted.  

 

 

If you accidentally deleted a folder or document, you can re-create the folder and re-upload the 
documents manually.  

8.2.6     Assigning Documents to Employees 

1. From the list of documents, use the checkboxes to select the documents you want to assign to 

employees.  

 

2. Click the “Assign to Employees” button.  
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3. Using the checkboxes, select the employees whom you want to assign these documents to. 

4. Identify if you require the selected employees to acknowledge this document.  

 

5. Click “Assign” to finish assigning the selected documents to your selected employees.  

8.2.7     Reviewing Acknowledged Documents  

1. Click the “Acknowledged Documents” button. 

 

2. A list of all employees and all acknowledged documents will appear. If you want to filter by employee, 

select the employee in the dropdown field.  
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8.3     Benefits 
Your benefits refer to any non-wage compensation that you offer to your employees, such as health insurance, 

life insurance, and others, that are in addition to their regular wages or salaries. You can review your benefits 

setup by navigating to Setup > Benefits.  

8.3.1     Benefit Vendors  

You must create at least one (1) benefit vendor prior to creating your benefit plans.  

8.3.1.1     Creating a Benefit Vendor 
1. Click the “Benefit Vendors” button. This will bring up your list of benefit vendors. 

 

2. Click the “+ New” button to add a new benefit vendor.  

 

3. Enter the required fields.  
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Field Name Description 

“Name” The name of the benefit vendor.   

“Address” The address of the benefit vendor. Two lines are provided for suite/unit numbers, if 
required.  

“City” The city or town of your benefit vendor.  

“Country” The country of your benefit vendor.  

“Province” The province, state, or territory of your benefit vendor.  

“Postal Code” The postal or ZIP code of your benefit vendor. 

“Website/Portal” The website or client portal for your benefit vendor. It must be a valid website address. 

“Notes” An optional field to enter any notes about the benefit vendor. 

“Logo” An optional ability to upload the logo for the benefit vendor. 

“Contact Persons” Contact persons and contact information (position, phone, email, etc.) for the benefit 
vendor. This can be a representative from your benefit vendor, a broker, etc. You can 
enter more than one contact person if required.  

4. Click the “Save” button to save your changes.  

8.3.1.2     Editing a Benefit Vendor 
1. Click the “Benefit Vendors” button. This will bring up your list of benefit vendors. 

 

2. From the list of benefit vendors, select the one you want to edit.  

3. Edit the fields as required.  

4. Click the “Save” button to save your changes.  

8.3.1.3     Deleting a Benefit Vendor 

 

You cannot delete a benefit vendor if it is the vendor for one of your benefit plans. You must first 
assign a new benefit vendor to the related benefit plan.  

1. Click the “Benefit Vendors” button. This will bring up your list of benefit vendors. 

2. From the list of benefit vendors, select the one you want to delete. 

3. Click the “Delete” button to delete the benefit vendor.  

4. Harmony will ask for your confirmation that you want to delete the benefit vendor. Click “Delete” to 

delete the benefit vendor. The benefit vendor is now deleted.  

 

 
If you accidentally deleted a benefit vendor, you can re-create the benefit vendor manually.  
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8.3.2     Benefit Plans  

8.3.2.1     Creating a Benefit Plan 

 

You must create a benefit vendor prior to creating the benefit plan. Review the Benefit Vendors 
section for more information.   

1. Click the “+ New” button to create a new benefit plan.  

 

2. Benefit plans are split into three sections: Details, Contribution, and Eligibility.  

a. ‘Details’ refers to the basic details about the benefit plan, including start/end dates, benefit 

vendor, and other identifying features. You can also upload any attachments to the plan, such 

as booklets or enrollment forms, that your employees can view and download.  

b. Contribution includes information about the employee and employer contributions to the 

benefit plan. These are simply the pay codes that are connected to this plan for payroll.   

c. ‘Eligibility Criteria’ identifies the criteria that an employee must meet in order to be enrolled 

into the benefit plan.  

3. In the ‘Details’ section, enter the required fields.  
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Field Name Description 

“Code” A short name for the benefit plan. 

“Name” The name of the benefit plan.  

“Start Date” The starting date of the benefit plan, such as January 1.  

“End Date” The end date of the benefit plan, such as December 31.  

“Type” The type of benefit plan. You can click the “View All” button to review, 
add, or edit any existing types.  

“Vendor” Identifies the benefit vendor for this plan. Review Benefit Vendors for 
more information. 

“Taxable” Identifies if this benefit plan is taxable or not.  

“Requires completion of probation” Identifies if an employee must complete their probationary period 
prior to enrolling and/or using this benefit plan.  

“Auto-enroll new employees” Identifies if all new employees are enrolled into this benefit plan 
automatically.  

“Allow employee to enroll” Identifies if you allow employees to enroll into this benefit plan. 

“Restrict number of dependents” Identifies if the benefit plan restricts the number of dependents that 
are enrolled. If yes, enter the maximum number of dependents. 

“Description” An optional field to describe the benefit plan.  

“Attachments” You can upload and attach any documents that an enrolled employee 
can view and download, such as any booklets or enrollment forms. 

4. In the Contribution section, enter the required fields.  

 

Field Name Description 

“Contribution 
Frequency” 

Identifies the frequency of which the employee and employer makes contributions to the 
benefit plan.  

“$” / “%” Identifies if the contribution amounts entered are in dollars ($) or percentages (%).  

“Employee 
Contribution” 

Identifies the employee contribution to the benefit plan. The dollar or percentage value is 
entered in the first field, and the maximum is identified in dollars. 

“Employer 
Contribution” 

Identifies the employer contribution to the benefit plan. The dollar or percentage value is 
entered in the first field, and the maximum is identified in dollars. 

“Pay Code” Identifies the pay code (i.e. payroll category code) that this contribution is mapped to. 

 

 

 

 

 



 

 

73 

 

5. In the ‘Eligibility Criteria’ tab, enter the required fields.  

 

Field Name Description 

“Allow enrollment if 
eligibility criteria is not met” 

Identifies if this benefit plan allows an employee to enroll into this benefit 
plan, even if they do not meet the eligibility criteria. 

“Age” Identifies the age range that the employee must fall into in order to enroll into 
this benefit plan. 

“Employee Types” Identifies the employee type(s) that an employee can have in order to enroll 
into this benefit plan. 

“Marital Status” Identifies the martial status(es) that an employee can have in order to enroll 
into this benefit plan.  

“Salary (Basic)” Identifies the basic salary range that the employee must fall into in order to 
enroll into this benefit plan.  

“Salary (Gross)” Identifies the gross salary range that the employee must fall into in order to 
enroll into this benefit plan. 

“Gender” Identifies the gender(s) that an employee can have in order to enroll into this 
benefit plan.  

“Is a Smoker” Identifies if the employees who smoke can enroll into this benefit plan. 

“Is a Student” Identifies the employees who are students can enroll into this benefit plan.  

“Years of Service” Identifies the years of service range that an employee must fall into in order 
to enroll into this benefit plan. 

6. Click the “Save” button to save your changes.  
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8.3.2.2     Editing a Benefit Plan 
1. From the list of benefit plans, select the plan you want to edit.  

 

2. Edit the tabs and fields as required. 

3. Click the “Save” button to save your changes. 

8.3.2.3     Reviewing the Changes Made to a Benefit Plan 
1. From the list of benefit plans, select the plan you want to view the audit history for.  

2. Click the “Audit History” button.  

 

3. This will bring up a list of changes that were made to the selected benefit plan. The person, the date and 

time, and the changes that were made can be viewed. 
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8.3.2.4     Enrolling Employees into a Benefit Plan 
1. From the list of benefit plans, click the “Assign” button next to the plan you want to enroll your 

employees into.  

 

2. A list of employees will appear. Those who are eligible and those who are not will be identified.  

3. Using the checkboxes, select the employees who you want to enroll into this benefit plan.  

 

4. Click the “Save” button to save your changes. 

8.3.2.5     Deleting a Benefit Plan 
1. From the list of benefit plans, select the benefit plan you want to delete.  

2. Click the “Delete” button to delete the benefit plan.  

3. Harmony will ask for your confirmation that you want to delete the benefit plan. Click “Delete” to delete 

the benefit plan. The benefit plan is now deleted.  

 

 
If you accidentally deleted a benefit plan, you can re-create the benefit plan manually.  
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8.4     Onboarding  
When you have a new hire, they will go through the onboarding process to catch them up to speed.  

8.4.1     Types of Onboarding Steps 

There are several different onboarding steps that you can choose from to add into your onboarding process 

record.  

• ‘Note / Text’ refers to a simple message to show to the new hire. You will be able to enter the message. 
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• ‘Acknowledgement’ refers to a text or message that requires your new hire to acknowledge before 

moving onto the next step of the onboarding process. It is very similar to the ‘Note/Text’ type. You will 

be able to enter both the note and the acknowledgement message.  

 

• ‘Personal Information’ refers to the Personal Information section in the employee profile, such as the 

employee’s name, date of birth, address, etc. Refer to the Employee List section of this user manual for 

more information. This is required and cannot be removed or duplicated in the onboarding process.  
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• ‘Direct Deposit Information’ refers to the employee’s bank accounts, to be use for the payroll module. 

You may allow the new hire to enter more than one (1) bank account. Please refer to the payroll module 

and user manual for more information. 

 

• ‘Tax Forms’ refers to the federal and state/provincial/territorial tax forms (e.g. W-4, TD-1, etc.) for your 

employees to fill out. These forms will be available to be pulled up in the payroll module to update 

payroll-related information for the new hire. Ensure that you are uploading a fillable PDF version of the 

tax form for your new hire to fill out. You can download this from the government websites for your 

country, state, province, and/or territory. 
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• ‘Professional Memberships & Certifications’ refer to the memberships that the new hire has joined or 

the certificates that the new hire has acquired. This is related to the section of the same name in the 

employee’s HR-related profile. Refer to the Employee Preferences section for more information. 
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8.4.2     Creating an Onboarding Process Record 

1. Navigate to Setup > Onboarding.  

2. Click the “+ New” button to create a new onboarding record.  

 

3. Enter the required fields. This will identify the onboarding record.  

 

Field Name Description 

“Code” A short name for the onboarding process record. 

“Name” The name of the onboarding process record.   

“Description” An optional field to describe the onboarding process record. 

“Copy From” Identifies if you want to copy the onboarding process record details 
from another existing onboarding process record.  

4. Click the save button to save your changes. 

5. Steps for the onboarding process will be shown in the bottom part of the window. Click “+ New” to add 

a new step.  
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If you already have steps in the onboarding process, you can select one and clone it to 
clone/duplicate it!  

 

6. Enter the required fields and click “Continue →” to move onto the next step.  

 

7. Enter additional fields as required. Review the Types of Onboarding Steps section for more information. 

8. You may want to preview the step prior to saving to ensure that it is as expected. You can click the 

“Preview” button to preview the step.  

 

9. Click the save button to save your changes.  

10. Repeat steps 5 through 9 for each step that you want to add to the onboarding process record.  

11. If you want to deactivate a step in the onboarding process record, but not delete it, use the toggle in the 

list of onboarding steps to toggle the step on (will be used) or off (will not be used).  

12. Steps in the onboarding process can be reordered by dragging and dropping the menu button on the 

left side of the window.  
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The ‘Summary’ provides a summary of all the fields that the new hire has filled during the 
onboarding process. As such, it will always be the last step of the onboarding wizard and cannot be 
reordered.  

13. Click the save button to save your changes to the onboarding process record itself.  

 

In the list of all onboarding process records, you can click the three (3) dots and select “Preview” 
to preview the entire onboarding process before you begin using it.  

 

8.4.3     Editing an Onboarding Process Record 

1. In the list of all onboarding process records, select the onboarding process record you want to edit.  

2. Edit the tabs and fields as required. 

3. Click the “Save” button to save your changes. 

8.4.4     Deleting a Step in an Onboarding Process Record 

 

Deleting a step in the onboarding process record will not affect new hires who are already using this 
onboarding process, nor past hires that have completed this onboarding process. If you want your 
new hires to follow the new onboarding process after deleting a step, you must re-initiate it. 

1. In the list of all onboarding process records, select the onboarding process record in which you want to 

delete a step from.  

2. In the list of all steps in the onboarding process record, select the step that you want to delete.  

3. Click the “Delete” button delete the step.  

4. Harmony will ask for your confirmation that you want to delete the onboarding step. Click “Delete” to 

delete the onboarding step. The onboarding step is now deleted.  

 

 
If you accidentally deleted an onboarding step, you can re-create it manually.  
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8.4.5     Deleting an Onboarding Process Record 

 

Deleting an onboarding process record will not affect new hires who are already using this 
onboarding process, nor past hires that have completed this onboarding process. If you want your 
new hires to follow a different onboarding process, you must initiate it for the employee. 

1. In the list of all onboarding process records, select the onboarding process record that you want to 

delete.  

2. Click the “Delete” button delete the step. 

 

3. Harmony will ask for your confirmation that you want to delete the onboarding process record. Click 

“Delete” to delete the onboarding process record. The onboarding process record is now deleted.  

 

 
If you accidentally deleted an onboarding process record, you can re-create it manually.  
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8.5     Offboarding 
Once your employees have been terminated or set to inactive in the system (and have a termination date), they 

are automatically assigned your user-defined offboarding checklist. You can review your offboarding checklist 

and other items by navigating to Setup > Offboarding.  

8.5.1     Editing the Offboarding Checklist  

There are three (3) sections of the offboarding checklist:  

A. Actions Prior to the Last Day refer to items that need to be completed before the employee’s termination 

date, as defined in their profile.  

B. Actions on the Last Day refer to items that need to be completed on the employee’s termination date, 

as defined in their profile.  

C. Actions After the Last Day refer to items that need to be completed after the employee’s termination 

date, as defined in their profile.   

We have provided common, default items on the checklist for each section. You can remove or modify them as 

required. 

1. To add additional items to the checklist, click the “Add” button. You can also identify the deadline or 

date for which this item must be completed.  

 

2. To delete existing items from the checklist, click the “Remove” button.  

 

 
If you accidentally removed an offboarding checklist item, you can re-create it manually. 
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3. Click the “Notifications” button to modify and customize when notifications are sent from the system. 

 

8.5.2     Editing the Exit Interview  

1. Click the “Exit Interview Sections” to modify which sections will be required to be completed during the 

exit interview. Using the checkboxes, select the sections that will be required. 

 

1. Click the “Documents to be Completed by Employee” button to identify which of your documents are 

required during offboarding. Using the checkboxes, select the documents that will be available. Review 

the Documents section for more information. 
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8.6     Competency Groups & Goals  
Competency groups and goals can be included in any performance appraisals that are conducted in the system 

for your employees. You can review your competency groups and goals by navigating to Setup > Performance.  

 

8.6.1     Competency Groups 

Competency groups (i.e. skillsets) are user-defined and can be included in your performance appraisals. You can 

review your competency groups by clicking the “Competency Groups” button.  

 

8.6.1.1     Creating a Competency Group  
A competency group can have an unlimited number of competencies. Each competency must have an assigned 

weight to it, which will contribute to the final rating of the employee when a performance appraisal is conducted.  

1. Click the “+ New” button to create a new competency group. 

 

2. Enter the required fields on the left side of the window to identify the competencies.  
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Field Name Description 

“Name” The name of the competency group.    

“Competency Name” The name of the competency in this group.  

“Description” The description of the competency in this group.  

“Weight %”  The weighting (percentage) of this competency in this group.  All 
competencies in the group must equal to 100%.  

3. Enter the required fields on the right side of the window to identify the scoring of these competencies 

in the group. We have provided common, default scores for you. You can remove or modify them as 

required. 

 

Field Name Description 

“Competency Scores Name” The name of the score that will be displayed when a performance appraisal 
is conducted.  

“Score” The score of the competency, which will be taken into the calculations of the 
final rating of an employee when a performance appraisal is conducted. 

4. Click the “Save” button to save your changes.  

8.6.1.2     Editing a Competency Group  
1. From the list of competency groups, select the group you want to edit.  

 

2. Edit the fields as required.  

3. Click the “Save” button to save your changes.  
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8.6.1.3     Deleting a Competency Group 

 

You cannot delete a competency group if it is assigned to one of your performance appraisals. You 
must first either delete the competency from the related performance appraisal or assign a new 
competency group to the related performance appraisal before deleting the group. 

1.  From the list of competency groups, select the group you want to delete.  

 

2. Click the “Delete” button to delete the competency group.  

3. Harmony will ask for your confirmation that you want to delete the competency group. Click “Delete” 

to delete the competency group. The competency group is now deleted.  

 

 
If you accidentally deleted a competency group, you can re-create the competency group manually.  
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8.6.2     Goals  

Goals to be met and their progress can be tracked in the system. You can review your goals by clicking the 

“Goals” button. 

 

8.6.2.1     Creating a Goal  
1. Click the “+ New” button to create a new goal.  

 

2. Enter the required fields. 

 

Field Name Description 

“Type” Identifies the type of goal – either company or department. For company goals, all 
employees in the company will be assigned to this goal. For departments, specify 
the department of which this goal is for.  

“Goal Name” The name of the goal.  

“Period” The date range of which the goal must be completed within.  

“Description” The optional description of the goal, to provide additional information. 

“Progress” Identifies the progress of the goal. If it is a company goal, the progress is 
automatically updated by all employees as a mean average. If it is a department goal, 
the progress is updated by all employees in the department as a mean average. 

“Use in Performance 
Appraisals” 

Identifies if this goal will be used in performance appraisals.  

3. Click the “Save” button to save your changes. 
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8.6.2.2     Editing a Goal 
1. From the list of goals, select the goal that you want to edit.  

 

2. Edit the fields as required.  

3. Click the “Save” button to save your changes.  

8.6.2.3     Editing the Goal Rating Scale 
If you’re using goals in your performance appraisals, you can modify the rating scale (i.e. completion scale) for 

the goals. This will contribute to the final rating of an employee in a performance appraisal. We have provided 

common, default ratings for you. You can remove or modify them as required. 

1. Click the “Rating Scale” button.  

 

2. Edit the fields as required.  

 

Field Name Description 

“Name” The name of the rating score. 

“Score” The numerical score for the employee in regard to a goal, which will be used in the 
calculations for the final rating of the employee when a performance appraisal is 
conducted. 

3. Click the “Save” button to save your changes. 
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8.6.2.4     Deleting a Goal  
1. From the list of goals, select the goal that you want to delete.  

 

2. Click the “Delete” button to delete the goal.  

3. Harmony will ask for your confirmation that you want to delete the goal. Click “Delete” to delete the 

goal. The goal is now deleted.  

 

 
If you accidentally deleted a goal, you can re-create the goal manually.  
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8.7     Performance Appraisals  

 

If you want to include goals and/or competency groups in your performance appraisals, you must 
create those first. Review the Goals section and Competency Groups sections for more information. 

8.7.1     Creating a Performance Appraisal 

1. Click the “+ New” button to create a new performance appraisal.  

 

2. Enter the required fields on the left side of the window.  

 

Field Name Description 

“Appraisal Name” The name of the performance appraisal.  

“Frequency” How often the performance appraisal is conducted.  

“Instructions” Any further instructions to provide to your employees and managers to conduct the 
performance appraisal.  
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3. Identify any preferences in the middle of the window.  

 

Field Name Description 

“Include Competency Group” Identifies if a competency group will be included in this performance 
appraisal. If yes, you must select the competency group.  

“Include Company Goals” Identifies if company goals will be included in this performance appraisal, 
where the goal type is ‘Company’.  

“Include Department Goals” Identifies if department goals will be included in this performance appraisal, 
where the goal type is ‘Department’.  

“Include Employee Goals” Identifies if employee goals will be included in this performance appraisal, 
where the goal type is ‘Employee’.  

“Include Professional 
Development” 

If ticked, allows you/the manager to upload additional documents to the 
performance appraisal record.  

“Include Employee Self-
Review” 

Identifies if the employee for whom the performance appraisal is for, is 
allowed to conduct the performance appraisal for themselves.  

“Keep Confidential from 
Employee” 

Identifies if the manager, reviewer, and final rating tabs of the performance 
appraisal record is hidden from the employee.  

“Allow Employee Comments” Identifies if the employee is allowed to make comments in the performance 
appraisal record. If yes, you may require this field as well. 

“Allow Manager Comments” Identifies if the employee’s manager is allowed to make comments in the 
performance appraisal record. If yes, you may require this field as well. 

“Allow Reviewer Comments” Identifies if the reviewer is allowed to make comments in the performance 
appraisal record. If yes, you may require this field as well. 
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4. Identify the final rating scale on the right side of the window.  

 

Field Name Description 

“Name” Identifies the name of the final rating.  

“Min %” Identifies the minimum percentage, after calculations are done, that the 
employee must have in the performance appraisal to be in this rating.  

“Max %” Identifies the maximum percentage, after calculations are done, that the 
employee must have in the performance appraisal to be in this rating.  

“Weight” Identifies the weighting of different components of the performance 
appraisal. All weightings must equal to 100%.  

5. Click the “Save” button to save your changes. 

8.7.2     Editing a Performance Appraisal 

1. From the list of performance appraisals, select the performance appraisal that you want to edit.  

 

2. Edit the fields as required.  

3. Click the “Save” button to save your changes. 
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8.7.3     Assigning a Performance Appraisal to Employees 

1. From the list of performance appraisals, select the performance appraisal that you want to assign to 

your employees.  

2. Click the “Assign” button to assign this appraisal. 

 

3. Using the checkboxes, select the employees that you want to assign this appraisal to. You can use the 

filters at the top of the window to filter the list of employees.  

 

4. Click the “Assign” button to save your changes. 
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8.7.4     Deactivating/Reactivating a Performance Appraisal 

 
When deactivating a performance appraisal, all historical and in-progress records will remain.  

1. From the list of performance appraisals, identify the performance appraisal that you want to deactivate 

or re-activate.  

2. Using the toggle, enable or disable the toggle to activate or deactivate accordingly.  

 

8.7.5     Deleting a Performance Appraisal 

 

You cannot delete a performance appraisal record if it has already been used in the past or is 
currently in use. You must delete all records before attempting to delete a performance appraisal. 

1. From the list of performance appraisals, select the performance appraisal that you want to delete.  

 

2. Click the “Delete” button to delete the performance appraisal.  

3. Harmony will ask for your confirmation that you want to delete the performance appraisal. Click 

“Delete” to delete the performance appraisal. The performance appraisal is now deleted.  

 

 

If you accidentally deleted a performance appraisal, you can re-create the performance appraisal 
manually.  
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8.8     Skills  
You can track your employees’ skills and identify their proficiencies to better understand your workforce. You 

can review your skills by navigating to Setup > Skills. 

8.8.1     Creating a Skill 

1. Click the “+ New” button to create a new skill.  

 

2. Enter the “Name” of the skill.  

3. Identify the “Proficiency Levels” of the skill. You can click the “+” button to add a proficiency level or the 

“-“ button to remove a proficiency level.  

 

4. Click the “Save” button to save your changes. 

8.8.2     Editing a Skill 

1. From the list of skills, select the skill you want to edit.  

 

2. Edit the fields as required.  

3. Click the “Save” button to save your changes. 
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8.8.3     Assigning a Skill 

1. From the list of skills, click the “Assign” button for the skill you want to assign to your employees.  

 

2. Use the checkbox on the left side of the window to select the employees you want to assign this skill to.  

 

3. Enter the fields as required for each selected employee.  

 

Field Name Description 

“Proficiency” Identifies the proficiency level of the employee for this skill.  

“Acquired Date” Identifies the date of when this employee acquired this skill. 

“Years of Experience” The number of years that this employee has this skill, based on the “Acquired Date”.  

4. Click the “Save” button to save your changes. 
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8.8.4     Deleting a Skill 

 

You cannot delete a skill if it is assigned to an employee. You must unassign the skill from the 
employee first before attempting to delete it. 

1. From the list of skills, select the skill that you want to delete.  

 

2. Click the “Delete” button to delete the skill.  

3. Harmony will ask for your confirmation that you want to delete the skill. Click “Delete” to delete the 

skill. The skill is now deleted.  

 

 
If you accidentally deleted a skill, you can re-create it manually.  
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8.9     Training  
You can manage and track the progress of any training courses offered by your organization. Your trainees can 

also upload any documents that may be required. You can review your training courses by navigating to Setup > 

Training. 

8.9.1     Creating a Training Course  

1. Click the “+ New” button to create a new training course.  

 

2. Enter the fields as required on the left side of the window.  

 

Field Name Description 

“Name” The name of the training course.  

“Type” Identifies if this training course is one-time only or is recurring.  

“Start Date” If the training course is one-time, identify the start date.  
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“End Date” If the training course is one-time, identify the end date. 

“Repeated Every” If the training course is recurring, identify how often it recurs.  

“On” If the training course is recurring, identify on which date it recurs.  

“Until” If the training course is recurring, identify the end date.  

“Length (days)” If the training course is recurring, identify the length of the training every time.  

“Description” An optional field to describe the training course.  

“Training Room” Identifies the training room in which this course takes place. Click the “View All” 
button to add, modify, or delete existing training rooms. 

“Trainer(s)” Identifies the employees who will be leading this training course. 

3. Identify the skills that will be learned upon completion of the training course in the middle of the 

window.  

a. You can enter the skill name at the bottom of this table to create new skills. Be sure to click the 

“Save” button to save the skill. 

b. To edit a skill, click the “Edit” button next to the skill to edit the name.  

c. To delete a skill, click the “Delete” button next to the skill to delete it.  

d. Using the checkboxes, select the skills that will be learned.  

 

4. Identify any additional information about the training course on the right side of the window. You can 

also upload and attach any documents that the employee can view and download.  
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Field Name Description 

“Instructions” An optional field to provide more information or additional instructions for your 
trainees. 

“Allow Employees to 
Self-Enroll” 

Identifies if employees are allowed to enroll themselves into this training course. If 
yes, you may require approval before official enrollment into the course. 

“Requires Approval 
After Completion” 

Identifies if, upon completion, it is required to be approved before the skills learned 
are saved to the employee’s profile.  

“Required for All 
Employees” 

Identifies if this training course is required or optional for all employees.  

“Default to New 
Employees” 

Identifies if this training course is automatically assigned to new employees. 

5. Click the “Reminders” button to send any reminders to the trainees of the course.  

 

6. Click the “Save” button to save your changes. 

8.9.2     Editing a Training Course 

4. From the list of training courses, select the training course you want to edit.  

 

5. Edit the fields as required.  

6. Click the “Save” button to save your changes. 
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8.9.3     Assigning a Training Course to Employees  

1. From the list of training courses, select the training course you want to assign to employees.  

2. Click “Assign”.  

 

3. Using the checkboxes, select the employees that you want to assign this training course to.  

 

4. Click “Assign” to save your changes.  
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8.9.4     Deleting a Training Course 

 

You cannot delete a training course record if it has already been used in the past or is currently in 
use. You must delete all records before attempting to delete a training course. 

4. From the list of training courses, select the training course that you want to delete.  

 

5. Click the “Delete” button to delete the training course.  

6. Harmony will ask for your confirmation that you want to delete the training course. Click “Delete” to 

delete the training course. The training course is now deleted.  

 

 
If you accidentally deleted a training course, you can re-create the training course manually.  

 

  



 

 

105 

 

8.10    Company Preferences 
Your company preferences are your company-wide settings and default selections for each employee. It is 

strongly recommended that you finish setting up the other areas of the setup above before adjusting your 

company preferences. When you create a new employee in Harmony, the employee’s profile will automatically 

take the settings defined here. These settings, however, can be overwritten at the employee level, which is 

covered in the Employee Preferences section. To review your company preferences, navigate to Setup > 

Preferences. 

1. Enter the required fields.  

 

You do not need to select a default approval path. This field is automatically populated according to 
your approval path setup. For more information, refer to the Harmony Company Setup User Manual. 

 

Field Name Description 

“Default Training 
Approval Path” 

Identifies the default approval path for training courses. 

“Hours in One 
Workday” 

Identifies the number of hours per day that your employees work.  

“Working Days” Identifies the dates that are considered ‘working days’ for your employees.  

“Default Assigned 
Benefit Plans” 

Identifies the benefit plans that are automatically assigned to new employees. Refer 
to the Benefits section for more information. 

2. Click the “Save” button to save your changes. 
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8.11   Employee Preferences  
Your company preferences were configurations that applied to all employees on a company level, but you can 

override the configurations for each employee individually. You can review your employee preferences by 

navigating to Setup > Employees.  

 

The preferences you define here are only for the employee that you select. If you want to have 
default values for every new employee you add to Harmony, review and update your Company 
Preferences. We recommend for you to go through this section only after all other HR sections are 
fully set up. 

1. Select the employee you want to review.  

 

2. Each employee has several different sections for you to review:  

a. General refers to general information about the employee, including driver license information, 

probationary periods, benefit plans, and language proficiency. 

b. Citizenship includes information about the employees’ citizenship and work permit, if any.  

c. Company Property refers to information about the employees’ company assets that are assigned 

or allocated to the employee.  

d. Employee Contacts includes information about the employee’s dependents and emergency 

contacts. 

e. Documents refers to all documents that are assigned to or uploaded for the employee.  

f. Employment History includes all current and previous employment history for the employee. 

g. Professional Memberships includes all memberships that the employee is a part of.  
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8.11.1   General  

1. Navigate to the ‘General’ tab.  

 

2. Update the fields as required.  

Field Name Description 

“Driver License Type” Identifies the driver license type. You can click the “View All” button to add, 
modify, or delete the different types. 

“Driver License Number” Identifies the employee’s driver license number. 

“Driver License Issue Date” Identifies the date of issue for the employee’s driver license.  

“Driver License Expiry Date” Identifies the expiry date for the employee’s driver license.  

“Probation End Date” Identifies the end date of the employee’s probationary period. 

“Ethnicity” Identifies the ethnicity of the employee. You can click the “View All” button 
to add, modify, or delete the different ethnicities. 

“Language” Identifies the name of the language that the employee has some proficiency 
in. 

“Read/Write Proficiency” Identifies the reading and writing proficiency of the language for the 
employee. 

“Oral Proficiency” Identifies the oral or verbal proficiency of the language for the employee. 

“Assigned Benefit Plans” Identifies benefit plans that are assigned to the employee.  

3. For “Assigned Benefit Plans”, you can click the “Select Dependents” to select the employee’s 

dependents and enroll them into the benefit plan. 

 

4. Click the “Save” button to save your changes.  
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8.11.2   Citizenship 

1. Navigate to the ‘Citizenship’ tab.  

2. Update the fields as required.  

 

Field Name Description 

“Countries of Citizenship” Identifies the countries that the employee has citizenship in. 

“Immigration Status” Identifies the immigration status of the employee. Additional fields may be 
required depending on what is selected.  

“Date Added” If immigration status is ‘work permit’, this field identifies the date that the work 
permit was added (i.e. today’s date).  

“Visa” If immigration status is ‘work permit’, this field identifies the Visa number. 

“Issuing Country” If immigration status is ‘work permit’, this field identifies the work permit’s 
issuing country.  

“Issuing Date” If immigration status is ‘work permit’, this field identifies the date that the work 
permit was issued.  

“Expiry Date” If immigration status is ‘work permit’, this field identifies the date that the work 
permit will expire.  

“Legally Entitled to Work” If immigration status is ‘work permit’, this field identifies if the employee is 
legally entitled to work. 

“Able to Travel” If immigration status is ‘work permit’, this field identifies if the employee is able 
to travel.  

“Notes” If immigration status is ‘work permit’, this field identifies additional information 
about the work permit that can be entered.  

3. If the immigration status is ‘Work Permit’, you can identify when notifications are sent when the expiry 

date for the work permit is approaching by clicking the “Notifications” button. 

4. Click the “Save” button to save your changes.  
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8.11.3   Company Property  

Company property, or company assets, can be assigned to an employee and updated when it is returned. To 

review an employee’s assigned company property, navigate to the ‘Company Property’ tab. 

8.11.3.1   Creating a Company Property  
1. Click the “+ New” button to create a new company property.  

 

2.  Enter the required fields.  

 

Field Name Description 

“Date Issued” Identifies the date that this company property was issued to the employee. 

“Item” Identifies the item that was issued to the employee. You can click the “View 
All” button to add, modify, or delete any existing items.  

“Details” Provides more information or details about the issued item.  

“Date Returned” Identifies the date that this item was returned (if applicable).  

3. Click the “Save” button to save your changes. 

8.11.3.2   Editing a Company Property  
1. From the list of company properties, select the record you want to edit.  

 

2. Edit the fields as required.  

3. Click the “Save” button to save your changes.  
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8.11.3.3   Deleting a Company Property  
1. From the list of company properties, select the record you want to delete.  

 

2. Click the “Delete” button to delete the record.  

3. Harmony will ask for your confirmation that you want to delete the record. Click “Delete” to delete the 

company property. The record is now deleted.  

 

 
If you accidentally deleted a company property record, you can re-create it manually.  
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8.11.4   Employee Contacts 

Your employees can have an unlimited number of contacts, including beneficiaries and dependents for the 

purposes of benefit plans, and emergency contacts. You can review the employee’s contacts by navigating to 

the ‘Employee Contacts’ tab. 

8.11.4.1   Creating an Employee Contact 
1. Click the “+ New” button to create a new employee contact.  

 

2.  Enter the required fields.  

 

Field Name Description 

“Relationship” Identifies the relationship to the employee that this contact has. 

“Emergency Contact” Identifies if this contact is an emergency contact for the employee. If yes, you 
can identify if they are the primary emergency contact for the employee. 

 
Only one emergency contact can be listed as ‘Primary’.  

 

“Dependent” Identifies if this contact is a dependent of the employee.  
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“Beneficiary” Identifies if this contact is a beneficiary of the employee. 

“First Name” The contact’s first name or given name.  

“Middle Name” The contact’s middle name.  

“Last Name” The contact’s last name, surname, or family name.  

“Date of Birth” The contact’s date of birth.  

“Gender” The contact’s gender.  

“SIN/SSN” The contact’s social insurance number or social security number.  

“Phone Number” The contact’s phone number.  

“Email Address” The contact’s email address.  

“Smoker” Identifies if this contact is a smoker. 

“Student” Identifies if this contact is a student. If yes, you must enter the name of the 
school that the contact attends. 

“Same as Employee 
Address” 

Identifies if this contact resides at the same address as the employee. If yes, it 
will auto-fill the remaining address-related fields.  

“Address” Identifies the address of the contact, if different from the employee.  

“Suite/Unit” Identifies the suite/unit of the address for the contact. 

“City” Identifies the city/town of the address for the contact.  

“Country” Identifies the country of the address for the contact. 

“Province” Identifies the province, state, or territory of the address for the contact. 

“Postal Code” Identifies the postal or ZIP code of the address for the contact.  

“Notes” Identifies any additional notes for the contact. 

3. Click the “Save” button to save your changes. 

8.11.4.2   Editing an Employee Contact 
1. From the list of employee contacts, select the record you want to edit.  

 

2. Edit the fields as required.  

3. Click the “Save” button to save your changes.  

8.11.4.3   Deleting an Employee Contact 
1. From the list of employee contacts, select the record you want to delete.  

 

2. Click the “Delete” button to delete the record.  
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3. Harmony will ask for your confirmation that you want to delete the employee contact. Click “Delete” to 

delete the employee contact. The employee contact is now deleted.  

 

 
If you accidentally deleted an employee contact, you can re-create it manually.  

8.11.5   Documents 

Documents can be uploaded or assigned on a per-employee level. The functionalities remain the same as the 

company-level. Review the Documents section for more information. You can review the employee’s documents 

in the ‘Documents’ tab. 
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8.11.6   Employment History 

You can track the employment history in both the current company and previous companies for the employee. 

You can review the employee’s employment history in the ‘Employment History’ tab. Any changes to the 

employee profile in the current company section will automatically be added to this list of records. 

8.11.6.1   Creating a Current Company Record  
1. In the Current Companies section, click the “+ New” button to create a new record.  

 

2. Enter the required fields. You can also upload and attach any related documents to this record.  

 

Field Name Description 

“Effective Date” Identifies when the change in the current company was made. 

“Status” Identifies the employee’s new employment status.  

“Employee Type” Identifies the employee’s new employee type. You can click the “View All” button 
to add, modify, or delete employee types.  

“Department” Identifies the employee’s new department.  

“Location” Identifies the employee’s new work location. 

“Manager” Identifies the employee’s new manager. 

“Comments” You can optionally add additional comments regarding this employment change. 

3. Click the “Save” button to save your changes.  
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8.11.6.2   Editing a Current Company Record  
1. From the list of current company records, select the record you want to edit.  

 

2. Edit the fields as required.  

3. Click the “Save” button to save your changes.  

8.11.6.3   Deleting a Current Company Record  
1. From the list of current company records, select the record you want to delete.  

 

2. Click the “Delete” button to delete the record.  

3. Harmony will ask for your confirmation that you want to delete the record. Click “Delete” to delete the 

current company record. The record is now deleted.  

 

 
If you accidentally deleted a current company record, you can re-create it manually.  
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8.11.6.4   Creating a Previous Company Record  
1. In the Previous Companies section, click the “+ New” button to create a new record.  

 

2. Enter the required fields. You can also upload and attach any relevant files. 

 

Field Name Description 

“Start Date” Identifies the start date of the employee’s previous employment. 

“End Date” Identifies the end date of the employee’s previous employment. 

“Company Name” Identifies the name of the company that the employee was previously employed 
with. 

“Position” Identifies the employee’s previous position at the company. 

“Location” Identifies the location of the employee’s previous employment.  

“Salary Upon Leaving” Identifies the employee’s salary upon leaving at their previous employment. 

“Reason for Leaving” Identifies the reason that the employee left their previous employment. You can 
click the “View All” button to add, modify, or delete the reasons.  

“Comments” Identifies the additional comments regarding the employee’s previous employment.  

3. Click the “Save” button to save your changes.  
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8.11.6.5   Editing a Previous Company Record  
1. In the list of previous company records, select the record you want to edit.  

 

2. Edit the fields as required.  

3. Click the “Save” button to save your changes. 

8.11.6.6   Deleting a Previous Company Record 
1. In the list of previous company records, select the record you want to delete.  

 

2. Click the “Delete” button to delete the record.  

3. Harmony will ask for your confirmation that you want to delete the record. Click “Delete” to delete the 

previous company record. The record is now deleted.  

 

 
If you accidentally deleted a previous company record, you can re-create it manually.  
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8.11.7   Professional Memberships 

Professional memberships can be tracked, and you can be sent notifications when professional memberships 

are about to expire. To review an employee’s memberships, navigate to the ‘Professional Memberships’ tab. 

8.11.7.1   Creating a Professional Membership Record 
1. Click the “+ New” button to create a new professional membership record.  

 

2. Enter the required fields.  

 

Field Name Description 

“Date Joined” Identifies the date that the employee joined this professional membership. 

“Renewal Date” Identifies the date that the employee must renew their membership.  

“Organization” Identifies the organization that issued this membership. You can click the 
“View All” button to add, remove, or modify any organizations. 

“Membership Type” Identifies the membership type for this membership record.  

“Designation” Identifies the designation (if any) for this membership record.  

“Employee Contributions” Identifies the dollar amount that the employee contributes to maintain their 
membership.  

“Employer Contributions” Identifies the dollar amount that the employer contributes to maintain this 
membership. 

3. Click the “Save” button to save your changes.  
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8.11.7.2   Editing a Professional Membership Record 
1. From the list of professional membership records, select the record you want to edit.  

 

2. Edit the fields as required.  

3. Click the “Save” button to save your changes.  

8.11.7.3   Setting Professional Membership Notifications  
1. Click the “Notifications” button.  

 

2. Update the notifications as required. You can click the “Add” button to add a new notification or click 

the “Remove” button to remove an existing notification. You can also assign to whom the notifications 

will go. 

 

3. Click the “Save” button to save your changes.  
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8.11.7.4   Deleting a Professional Membership Record  
1. From the list of professional membership records, select the record you want to delete.  

 

2. Click the “Delete” button to delete the record.  

3. Harmony will ask for your confirmation that you want to delete the record. Click “Delete” to delete the 

professional membership record. The record is now deleted.  

 

 
If you accidentally deleted a professional membership record, you can re-create it manually.  

8.11.8   Skills 

Skills can be tracked and assigned to employees to identify their proficiency levels. To review an employee’s 

skills, navigate to the ‘Skills’ tab. 

A list of acquired skills are shown in the table. Select one of the skills in the table to modify the “Acquired Date” 

if necessary.  
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8.12   Notifications  
Notifications can be triggered and sent to any users of Harmony that you choose. Notifications can be sent by 

email, on the web (in the notification center in Harmony), and/or through the mobile app. You can review your 

notifications by navigating to Setup > Notifications.  

8.12.1   Enabling/Disabling a Notification 

1. In the list of notifications, identify the notification that you want to enable or disable.  

2. Using the toggles, enable or disable the notification.  
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8.12.2   Selecting an Email Template for a Notification 

 

You must have created an email template to be assigned prior to enabling or setting an email 
notification. For more information, review the Harmony Company Setup User Manual.  

1. In the list of notifications, identify the notification you want to assign an email template for. 

2. Click the “Edit” button.  

 

3. Select the email template that you’d like to assign this notification to. You can also click “Add New 

Template” to create a new email template.  
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8.12.3   Choosing to Whom a Notification is Sent 

1. In the list of notifications, identify the notification you want to choose to whom it is sent.  

2. Click the “Configuration” button.  

 

3. Select the users or employees to whom you’d like to sent this notification when it is triggered.  

 

4. Click the “Save” button to save your changes.   
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9.0     Using Harmony Human Resources 

9.1     Your Administrative Dashboard  
Your administrative dashboard gives you a quick summary of various aspects of your Human Resources module 

for the current date and time. All the information displayed is updated in real-time. Your dashboard will have 

slight differences from that of your regular users, such as employees and managers.  

You can use the department and date filters to filter your dashboard. 

 

As the administrator, you can customize what your employees and managers will see and modify on 
their dashboard. Refer to the Harmony Company Setup User Manual for more information.  

 

Field Name Description 

“Announcements” Identifies the announcements that are created and posted for employees to view. 

“Notepad” Your own personal notepad!  

“Current Employees” A pie chart of the current employee breakdown, by employee type. 

“Upcoming Dates” 
Identifies upcoming holidays (from the holiday calendar), birthdays, anniversary 
dates, and custom special dates that are in the near future. 

“New Hires” 
A bar graph of the new hire you’ve hired in the past few months, broken down by 
employee type. 

“Time Off Taken” 
Identifies the upcoming, taken, and remaining balance of time off types that are 
set up for each employee.  
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9.1.1     Announcements  

Announcements can be created and published for other users of Harmony to view.  

9.1.1.1     Creating an Announcement 
1. Click the “Add” button in the ‘Announcements’ widget.  

 

2. Enter the required fields.  

 

Field Name Description 

“Subject” 
The subject of the announcement. This will be displayed in the ‘Announcements’ 
widget. 

“Post Date” The date that this announcement will be posted.  

“Remove Post” 
The date that this announcement will be removed. If no date is specified, the 
announcement will remain in the ‘Announcements’ widget forever.  

“Body” The body of the announcement.  

3. Click the “Save” button to save your changes. 
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9.1.1.2     Editing an Announcement 
1. From the list of announcements, select the announcement you want to edit.  

 

2. Click the “Edit” button. 

 

3. Edit the fields as required.  

4. Click the “Save” button to save your changes.  

9.1.1.3     Deleting an Announcement 
1. From the list of announcements, select the announcement you want to delete.  

2. Click the “Delete” button to delete the announcement.  

3. Harmony will ask for your confirmation that you want to delete the announcement. Click “Delete” to 

delete the announcement. The announcement is now deleted.  

 

 
If you accidentally deleted an announcement, you can re-create it manually.  
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9.1.2     Upcoming Dates  

Your upcoming dates will automatically be captured from several places:  

A. Birthdays are captured from the employees’ dates of birth from their employee profile 

B. Work Anniversaries are captured from the employees’ start dates from their employee profile  

C. Holidays are captured from the holiday calendar that is set up in the system  

However, you can also create manual dates if there are other special dates that you want to track, such as other 

holidays that are observed or team socials. You can review your upcoming dates in your dashboard in the 

‘Upcoming Dates’ widget. 

9.1.2.1     Creating a Manual Date 
1. Click the “Add” button to create a new manual date.  

 

2. Enter the required fields. 

 

Field Name Description 

“Date” The date of the manual date.  

“Description” The description or subject of the date.  

“Recurring” 
Identifies if this date is recurring. If yes, you can enter how frequently it recurs and 
when the last date will be.  

“Limit to” 
Identifies if this date is limited to a specific department or location. If yes, select 
which department and/or location. 

3. Click the “Save” button to save your changes.  
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9.1.2.2     Editing a Manual Date 
1. From the list of dates, select the date you want to edit.  

 

2. Edit the fields as required.  

3. Click the “Save” button to save your changes.  

9.1.2.3     Deleting a Manual Date 

 
You cannot delete birthdays, work anniversaries, or holidays that weren’t manually created.  

1. From the list of dates, select the date you want to delete.  

2. Click the “Delete” button to delete the date.  

 

3. Harmony will ask for your confirmation that you want to delete the date. Click “Delete” to delete the 

date. The date is now deleted.  

 

 
If you accidentally deleted a date, you can re-create it manually.  
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9.1.3     Time Off Taken 

The ‘Time Off Taken’ widget displays the time off that is taken per employee, per time off type. Use the 

dropdown field to switch between different time off types. You can also click on an employee’s name to be 

redirected to their employee profile for more information about any upcoming time off (approved but not yet 

taken) and current time off balances.  

 

9.1.4     Notepad 

Your notepad is your very own personal memo pad. This is the place where you can write down any reminders 

or notes that you need to remind yourself. This notepad is not visible to any other user, so you can use it for 

anything. 
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9.2     Employees 
The Employees section provides information about the employees themselves, whether they are a current 

employee, a new hire, or an employee who is inactive/terminated. You can review your employees by navigating 

to Employees in your navigation menu.  

9.2.1     Employee List 

Your Employee List is a list of all your current employees.  You can review your employees by navigating to 

Employees > Employee List. When you select an employee from the list, you can review any additional 

information about the employee.  

 

 

Only the administrative user will have access to all employees. Regular users, such as managers and 
employees, will have restricted access. Managers can only view themselves and the employees that 
they are the manager of. Employees are only allowed to view their own profile.   

You can switch between employees using the dropdown field at the top of the page. 

 

 

Most of the tabs in the employee profile are read-only. You can modify the HR-related fields in the 
employee preferences under Setup > Employees.    
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9.2.1.1     Personal Information 
The ‘Personal Information’ tab for the employee includes all personal details, including their address, language 

proficiency, and driver’s license information (read-only). This is a combination of items that can be found in the 

employee profile (review the Harmony Company Setup User Manual for more information) and the employee 

preferences that can be found in the Setup menu. Review the Employee Preferences section for more 

information. You can also write any additional notes about this employee here. 

 

9.2.1.2     Job Information 
The ‘Job Information’ tab includes all job-related information, such as department, supervisor, and company 

property that was issued to the employee.  
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9.2.1.3     Benefits 
The ‘Benefits’ tab includes all the benefit plans that the employee and their dependents are enrolled into. You 

can click on the benefit plan to view the details of the benefit plan. Review the Benefit Plans Setup section for 

more information. 

 

9.2.1.4     Citizenship 
The ‘Citizenship’ tab includes information about the employee’s citizenship, or their immigration status if 

applicable. The work permit information is also visible. The process is the same as found in the Citizenship section 

in the setup menu. 

 

9.2.1.5     Contacts 
The ‘Contacts’ tab includes information about the employee’s emergency contacts, dependents, and/or 

beneficiaries. You can also add any additional contacts if required. The process is the same as found in the 

Employee Contacts section in the setup menu.  
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9.2.1.6     Documents 
The ‘Documents’ tab includes all relevant and assigned documents for the employee. You can also add, upload, 

or assign any additional documents if required. The process is the same as found in the Employee Documents 

section in the setup menu.  

 

9.2.1.7     Time Off 
The ‘Time Off’ tab includes the entitled balance, used, upcoming, and remaining for the remainder of the policy 

year for each time off type. This tab also includes any time off details that were previously taken. 

 

9.2.1.8     Training 
The ‘Training’ tab includes the skills and history of training courses that are in progress and completed by the 

employee.  
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9.2.2     Onboarding 

Your Onboarding section is a list of all your new hires. You can review your new hires by navigating to Employees 

> Onboarding. New hires who have begun the onboarding process will appear here. You can initiate the 

onboarding process for a new hire by navigating to Setup > Onboarding instead. 

9.2.2.1     Inviting New Hires & Emailing the Onboarding Link 

 

You must have set up your email template to invite a new hire to complete their onboarding. Refer 
to the Email Templates section and the Notifications section for more information.  

If you do not have all the required information from the employee to create an employee profile, you can 

optionally send the link to the new hire to provide you with the required information themselves. Upon 

completion, it will be sent to the administrative user, who will confirm and add the required job-related 

information, such as departments and employee numbers. Navigate to Setup > Onboarding.  

1. In the list of all onboarding process records, click the three (3) dots for the process you want to initiate 

for a new hire.  

2. Select ‘Invite New Hire’.  

 

3. Enter the “Name” and “Email” for the new hire that you want to initiate the onboarding process for.  

4. If you want to initiate the selected onboarding process for more than one new hire, click the “+” button 

to add another row and enter the subsequent new hires.  

 

5. Click “Send” to send the invitation. Your new hire(s) will receive an email with the onboarding link for 

them to complete.  

 

As soon as the new hire begins the onboarding process, you cannot modify it unless you send a new 
one.   
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9.2.2.2     Reviewing New Hires’ Onboarding Process 
This is the list of new hires who are currently in the midst of their onboarding process. You can select one new 

hire to review their current process and identify what has been completed or not.  

When a new hire has not yet submitted their information, the ‘Approval Status’ will be “Draft”. Once it is 

submitted, it will be “Submitted”. Once you have entered additional information, it will be “Pending”. Once the 

onboarding process is completed, it will be “Approved” and the employee record will be created. 

 

9.2.2.3     Re-Emailing New Hires’ Onboarding Process  
1. From the list of new hires, click the “Email” button to re-invite the new hire to complete their onboarding 

wizard.  
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9.2.2.4     Approving a New Hire’s Onboarding Process 
Once a new hire has submitted their information in the onboarding process, the ‘Approval Status’ will be 

changed to “Submitted”. You and your approver(s) can approve of the information and add additional 

information if required.  

1. From the list of new hires, select the new hire record that you want to approve.  

2. Review the information in all steps of the onboarding wizard until the final step.  

3. Click “Approve” to approve the submission, or “Reject” to reject the submission. 

 

4. Once approved, you will be required to enter additional Job Information data.  

 

5. Click the “Save” button to save your changes. The ‘Approval Status’ will now be “Approved” and the 

employee record is created.  
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9.2.3     Offboarding 

When an employee’s employment status is set to ‘Inactive’ or ‘Terminated’, and a termination date is entered, 

they will automatically be sent to the offboarding process. You can review employees in the offboarding process 

by navigating to Employees > Offboarding.  

 

Whenever the employee is sent to the offboarding process, the current offboarding checklist, 
documents, and other items are automatically saved. Any changes to the offboarding checklist, 
documents, or other items will not automatically be refreshed for this employee. It is strongly 
recommended that you ensure your current offboarding setup is 100% complete.    

9.2.3.1     Reviewing an Employee’s Checklist 
1. From the list of offboarding employees, select the employee you’d like to review.  

2. You can switch between other employees in the offboarding process using the dropdown field at the 

top of the page. 

 

3. The checklist is displayed in the ‘Checklist’ tab for the employee. The items to be done prior to the 

employee’s last day are listed, followed by items to be done on the last day, and then after the last day. 

Each item will also include the due date. If the date has already passed, it will be listed in red. You can 

switch between the different tabs for other information, such as documents and the exit interview.  

 

4. Whatever item is complete, use the checkboxes to confirm that it is complete.  
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5. You can download or print this checklist for your records.  
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9.2.3.2     Completing the Exit Interview 
1. From the list of terminated employees, select the employee that you’d like to complete the exit 

interview for. 

 

2. Navigate to the ‘Exit Interview’ tab for an employee.  

3. Enter the required fields.  

 

Field Name Description 

“Interview Date” The date of the exit interview. By default, it is selected to the current date. 

“Interviewer” The person conducting the exit interview for the employee. 

“Employee Length of Service” 
The employee’s total length of service. This is automatically generated from 
the employee’s start date and termination date.  

“Termination Status” Identifies if the employee’s termination was voluntary or involuntary. 

“Reason for Termination” Identifies the reason of this employee’s termination. 

“Interviewer Comments” The comments from the interviewer regarding this exit interview.  

“Employee Comments” The comments from the employee regarding this exit interview. 

4. Click the “Save” button to save your changes. 
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9.3     Employee Development 
The Employee Development section is where you can manage and hone your current employee workforce.  

9.3.1     Goals 

Goals and their progress can be created, managed, and tracked in Harmony for each employee. You can identify 

goals to be either company (in which all employees of the company will have this goal), department (in which 

all the employees in a specific department will have this goal), or employee (in which only one employee will 

have this goal). You can review the goals for each employee by navigating to Employee Development > Goals.  

Goals are grouped by employee. You can use the filters at the top of the page to filter through the list of goals. 

 

9.3.1.1     Creating a New Goal  
1. Click the “+ New” button.  

 

2. Enter the required fields.  

 

You cannot enter the name or description of the goal if it is of the type ‘Company’ or ‘Department’. 
You can modify the company and department goals in the Goals section of your setup.  
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Field Name Description 

“Type” Identifies the type of goal – either company or department. For company goals, all 
employees in the company will be assigned to this goal. For departments, specify 
the department of which this goal is for.  

“Goal Name” The name of the goal.  

“Period” The date range of which the goal must be completed within.  

“Description” The optional description of the goal, to provide additional information. 

“Progress” Identifies the progress of the goal. If it is a company goal, the progress is 
automatically updated by all employees as a mean average. If it is a department goal, 
the progress is updated by all employees in the department as a mean average. 

“Use in Performance 
Appraisals” 

Identifies if this goal will be used in performance appraisals.  

3. Click the “Save” button to save your changes.  

9.3.1.2     Editing an Existing Goal  
1. From the list of goals, select the goal you want to edit.  

 

2. Edit the fields as required.  

3. Click the “Save” button to save your changes.  

9.3.1.3     Exporting Goals  
1. Click the “Export” button.  

 

2. Select the file type that you would like to export. 

 

3. Enter the name of the file for the export. 
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4. Click “Export” to complete the export.  

 

Exporting the file will download it to your browser’s default downloads folder. Check your browser 
settings or with your IT person to confirm where your browser’s default downloads folder is. 

9.3.1.4     Deleting a Goal  
1. From the list of goals, select the goal you want to delete.  

2. Click the “Delete” button to delete the goal.  

3. Harmony will ask for your confirmation that you want to delete the goal. Click “Delete” to delete the 

goal. The goal is now deleted.  

 

 
If you accidentally deleted a goal, you can re-create it manually.  
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9.3.2     Performance Appraisals 

Goals and their progress can be created, managed, and tracked in Harmony for each employee. You can identify 

goals to be either company (in which all employees of the company will have this goal), department (in which 

all the employees in a specific department will have this goal), or employee (in which only one employee will 

have this goal). You can review the goals for each employee by navigating to Employee Development > Goals.  

Goals are grouped by employee. You can use the filters at the top of the page to filter through the list of goals. 

 

9.3.2.1     Creating a Performance Appraisal 
1. Click the “+ New” button.  

 

2. Enter the required fields.  

 

Field Name Description 

“Employee” Identifies the employee for whom the performance appraisal is for.  

“Performance 
Appraisal” 

Identifies the performance appraisal to create. Review the Performance Appraisal 
section for more information. 

“Appraisal Period” Identifies the date range for which this appraisal is for. 

3. Click the “Save” button to save your changes.  

4. Enter the required fields. 

5. Click the “Save” button to save your changes.  

 

If you allowed an employee to review themselves, the manager must initiate the performance 
appraisal first.  
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9.3.1.2     Initiating an Existing Performance Appraisal 
Initiating a performance appraisal will start the process of the performance appraisal. Up until the appraisal is 

initiated, the manager or administrative user can modify the performance appraisal as required. Once the 

appraisal is initiated, the employee (if allowed) will complete the appraisal first, followed by the manager, and 

finally the reviewer. 

1. From the list of appraisals, select the appraisal record you want to initiate.  

2. Navigate to the ‘Manager Appraisal’ tab. 

3. Click the “Initiate” button.  

 

9.3.1.3     Exporting Performance Appraisals  
1. Click the “Export” button.  

 

2. Select the file type that you would like to export. 

 

3. Enter the name of the file for the export. 

4. Click “Export” to complete the export.  

 

Exporting the file will download it to your browser’s default downloads folder. Check your browser 
settings or with your IT person to confirm where your browser’s default downloads folder is. 
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9.3.1.4     Signing Off on Performance Appraisals 
Once the employee and the employee’s manager have completed their portions of the performance appraisal, 

the administrative user (or the reviewer) must sign off on the appraisal before the final rating is calculated.  

1. From the list of appraisals, select the appraisal record you want to sign off.  

 

2. Navigate to the ‘Reviewer’ tab. 

3. Click the “Sign Off” button.  

9.3.1.5     Reviewing the Final Report 
Once all the tabs and appraisals are completed and signed off, you can review the final report. All the weightings 

from the performance appraisal setup and the scores by the employee and manager are taken into consideration 

in the final calculation.  

1. From the list of appraisals, select the appraisal record you want to review the final report for.  

 

2. Navigate to the ‘Final Report’ tab. 

3. You can click the “Download” button to export the final report for this appraisal.  
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9.3.3     Training 

Training courses are managed in the setup section of the Human Resources module. You can review the Training 

section for more information. There are three (3) sections of Training:  

A. Available Courses include a list of training courses that the employee can enroll in if self-enrollment is 

allowed in the training course setup. 

B. My Courses include a list of training courses that the logged-in user is currently enrolled into but have 

not yet completed.  

C. Requests include the requests made by employees – including enrollment requests (if required) and 

completion requests (if required). These requests will require approval or rejection, if you are the 

approver for the training course. 

9.3.3.1     Available Courses 
Any training courses that allow for self-enrollment will be listed in the Available Courses section. You can review 

any available courses to be enrolled into by navigating to Employee Development > Training > Available Courses. 

1. From the list of available courses, select the course you want to enroll in.  

 

2. Click “Enroll” to enroll yourself into the training course.  

 

3. If the training course requires approval for enrolling, your request must be approved prior to starting 

the training course. Otherwise, you are automatically enrolled, and you may start the training course 

immediately.  

 

After submitting a request to enroll into a training course, your request can be found in the Requests 
section. After successfully enrolling into a training course, it can be available for you to start in the 
My Courses section. 
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9.3.3.2     My Courses 
You can review your own courses by navigating to Employee Development > Training > My Courses.  

 

The logged-in user must have an employee profile attached to view the current enrolled courses. 
Review the Security section in the Harmony Company Setup User Manual for more information. 

1. From the list of courses, select the training course that you want to review.  

 

2. Update the progress or enter any notes as required.  

 

 

Upon 100% progress, the system will treat this training course as completed. If the completion 
requires approval, then the approver for the training course will be sent to the approver. The skills 
learned from the completed training course will not be saved to the employee profile until it is 
approved. 

3. Click the “Save” button to save your changes.  
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9.3.3.3     Requests 
You can review the requests that are pending approval or rejection in the Requests section of Training. If you are 

the employee who made a request, you can also review your own requests that are pending approval. You can 

review any outstanding requests by navigating to Employee Development > Training > Requests.  

 

You must be the approver of the training course approval path to approve or reject any enrollment 
or completion requests of training courses. Review the Harmony Company Setup User Manual for 
more information. 

9.3.3.3.1     Approving or Rejecting a Request 
1. From the list of requests, select the request you want to approve or reject.  

 

2. Click the “Approve” button to approve the request, or the “Reject” button to reject the request. If you 

are rejecting the request, you must enter a reason for the rejection. 
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9.3.3.3.2     Mass Approving or Rejecting Requests 
1. In the list of requests, use the checkboxes to select the requests you want to approve or reject.  

 

2. Click the “Approve” button to approve all selected requests, or the “Reject” button to reject all selected 

requests. If you are rejecting the request, you must enter a reason for the rejection. 
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9.4     Reporting 
Harmony provides you with dynamic reporting and analytics in your Human Resources module. This means that 

while Harmony will provide you with all the standard reports, you can customize how you want your reports to 

be displayed and saved. You can review your reports by navigating to Reports.  

9.4.1     Available Reports  

The reports below are the standard reports that come preloaded with Harmony Human Resources. Each report 

has its own fields that you can move, group, sort, or filter. 

Report Name Description 

Benefit Plans Setup Provides information about how your benefit plans are set up. 

Benefit Vendor Setup Provides information about how your benefit vendors are set up. 

Employee Benefits Headcount 
Provides a headcount of the number of employees who are enrolled 
into each benefit plan. 

Employee Birthdays Provides information about employees and their birthdays.  

Employee Detailed Information Provides detailed information about all your employees.  

Employee Emergency Contacts Provides information about employees and their emergency contacts. 

Employee Seniority Provides information about employees and their work anniversaries. 

Employee Training Headcount 
Provides a headcount of the number of employees who are enrolled or 
completed a training course. 

Goals Setup Provides information about how your goals are set up. 

Performance Appraisal Headcount 
Provides a headcount of the number of employees who have a 
performance appraisal record.  

Performance Appraisal Setup 
Provides information about how your performance appraisals are set 
up. 

System Audit 
A full system audit of all changes that are made in the HR module, 
including what was changed, who changed it, and when it was changed. 

Training Course Setup Provides information about how your training courses are set up. 

 

9.4.2     Opening a Report  

1. In the dropdown field, select the report that you want to view.  
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9.4.3     Editing a Report  

1. In the dropdown field, select the report that you want to modify.  

2. Each report will have different filters available. Use the filters and click the refresh button to confirm 

your filters.  

 

3. Drag and drop the columns according to how you want them to be displayed.  

 

4. Drag any field to the ‘Row Group’ section to group your report by the selected field.  
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5. To show/hide any fields, click “Columns” on the far-right side to display all available fields. Tick the fields 

that you want to be shown and untick the fields that you want to hide. 

 

9.4.4     Saving a Report  

Once you have manipulated or edited a report that you want to save for quick access in the future, you can save 

it under a customized name to easily help you identify it.  

1. Ensure that the report being displayed is exactly how you want it. Review the Editing a Report section 

for more information. 

2. Click the save button.  

 

3. Enter a name for your report.  

 

4. Click the save button to save your changes.  
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9.4.5     Exporting a Report 
You can export your report in a variety of formats, including Excel or printing it out.  

1. In the list of reports, select the report you want to export.  

2. To export the report to an Excel file or comma delimited (CSV) file, click “Export”.  

 

3. Select the file type you want to export to.  

 

Exporting the file will download it to your browser’s default downloads folder. Check your browser 
settings or with your IT person to confirm where your browser’s default downloads folder is. 

4. To print out your report, click the “Print” button.  

 

 

Depending on your report layout, printing may not be optimized. Keep in mind that this report is 
like a spreadsheet in Excel and having too many columns may print very small or on multiple pages. 
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9.4.6     Deleting a Report  

 

You can only delete a report that you’ve created. You cannot delete a report that another user 
created, and you cannot delete the standard reports that are provided for you.  

1. In the list of reports, identify the report that you want to delete.  

2. Click the delete button to delete the report.  

 

3. Harmony will ask for your confirmation that you want to delete the clock report. Click “Delete” to delete 

the report. The report is now deleted.  

 

 
If you accidentally deleted a report, you can re-create it manually.  
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Contact Paymate Support 
Before you contact the Paymate support team directly, please contact your system administrator and/or review 

our available resources.  

Paymate Knowledge Base  
Paymate’s knowledge base contains a wide variety of help documents, guides, and how-to videos. We strongly 

recommend browsing or reviewing our articles to fix an issue you may have with Harmony.  

You can access Paymate’s knowledge base here: https://helpdesk.paymatesoftware.com/  

Paymate’s YouTube Channel  
Paymate’s YouTube channel contains several videos on a variety of topics. From software demos to step-by-step 

guides on how to close your year in Harmony, you can refer to these videos for a step-by-step explanation for 

the solution to an issue you may have.  

You can access Paymate’s YouTube channel here: 

https://www.youtube.com/channel/UCzQF_VMF_5DiNdUtlaanMbA  

 

If you still require additional help with Harmony, please feel free to contact the Paymate support team directly. 

We will be happy to help you and answer any questions you may have.  

Email Us:  support@paymatesoftware.com 
Call Us:  1-866-PAYMATE (1-866-729-6283) ext. 1 
Visit Us:  www.paymatesoftware.com  

 

  

https://helpdesk.paymatesoftware.com/
https://www.youtube.com/channel/UCzQF_VMF_5DiNdUtlaanMbA
mailto:support@paymatesoftware.com
http://www.paymatesoftware.com/
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